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In regard to data acquisition systems, the following terminology is used: 
 ZonicBook refers to a ZonicBook/618E. 
 WaveBook refers to WaveBooks in general, except when a specific model is 

specified. 
 IOtech 600 Series refers to dynamic signal analyzers 640, 650,  652, and 655.   

 

 

Reference Note: 
The information provided in this manual applies to the above noted analyzers with 
exceptions as noted.  Refer to your system’s specific hardware documentation in regard to 
hardware setup.  PDF versions of documents are included on CD and on our website.  They 
are also installed in the Programs group on your PC as a part of product support, during the 
software installation process. 

 

What is eZ-TOMAS? 
eZ-TOMAS (Total Online Monitoring and Analysis Software) is designed to acquire, limit check, store, 
and analyze vibration and process data from rotating machinery.  eZ-TOMAS can be used with ZonicBook, 
WaveBook, and IOtech 600 Series hardware.  The application can be used as a server for scenarios 
involving remote control.  Remote viewing is possible via eZ-TOMAS Remote. 

Analog input signals are typically associated with a specific machine train; and can be any combination of 
the following: 

•  Proximity 

•  Velocity 

•  Accelerometer 

•  Tachometer (up to 32 tach references supported) 

•  DC proportional voltage 

•  Microphone 

•  Pressure 

Note:  The eZ-TOMAS Remote application, purchased separately, allows you to remotely monitor and/or 
control eZ-TOMAS applications through client/server architecture.  If needed, refer to Chapter 10 
for additional information. 
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Installing and Starting the Application 

System Requirements 

Verify that you have a 32-bit version of Windows, the following items, 
and meet or exceed the minimum requirements listed.   

• For Ethernet devices: 10/100BaseT Ethernet port [on PC or on a hub 
connected to the Ethernet] 

• For USB devices: a USB port on the host PC [USB2.0 recommended] 
• Monitor: SVGA, 1024 x 768 screen resolution 
• Windows 2000 SP4 and Windows XP users: 

PC with Intel™ Pentium 4 or equivalent 
1 GB memory; 10 GB disk space 

• Windows Vista (x86) users: 
PC must be Windows Vista Premium Ready 

• Dynamic Signal Analysis (DSA) CD 
• License Keys for eZ-TOMAS and/or eZ-TOMAS Remote, as applicable 
• For eZ-TOMAS users wanting to acquire data: Data acquisition hardware and associated cables and power 

supplies.  Compatible hardware includes ZonicBook/618E, WaveBooks, and IOtech 600 Series.   
• User documentation: available in pdf format on CD and on-line at: 

 
 

www.iotech.com/manuals.html 

 

If using eZ-TOMAS Remote, the version numbers of eZ-TOMAS Remote and eZ-TOMAS 
must match. 

  

 

If using eZ-TOMAS Remote, be aware that an effective firewall will likely alert the  
eZ-TOMAS host application when eZ-TOMAS Remote is trying to monitor information or 
take control; and will block such remote attempts.  We recommend that you maintain 
firewall protection; however, you will need to set your firewall to allow access to  
eZ-TOMAS Remote.  As used here, providing firewall access means making ports used by 
clients and servers open [on both ends].  

 

Software Installation 

1. Start Windows. 

2. Close all running applications. 

3. Insert the Dynamic Signal Analysis CD into your CD-ROM drive and wait for the CD to 
auto-run. 

If the CD does not start on its own: 

(a) click the desktop’s <Start> button 
(b) choose the Run command 
(c) select the CD-ROM drive, then select the setup.exe file. 
(d) click <OK>. 

An Opening Screen will appear. 

4. Click the <ENTER SETUP> button. 

5. From the hardware selection screen [which follows a licensing agreement], select the type of 
data acquisition device you are using from the drop-down list. 

6. Continue to follow the on-screen instructions. 

 

http://www.iotech.com/manuals.html
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Reference Notes: 
Adobe Acrobat PDF versions of documents pertaining to hardware and software are 
automatically installed onto your PC’s hard-drive as a part of product support at the time 
of software installation.  The default location is the Programs group, which can be 
accessed via the Windows Desktop Start Menu. 

 

Running eZ-TOMAS  

To run eZ-TOMAS, double-click the associated icon or use your Windows desktop Start button to navigate to the 
program.  This is located in the programs group by default. 

The first time you start the application you will be prompted for your name, your company name, and a license 
number.  The number will activate eZ-TOMAS for every day operations.  Note that the eZ-TOMAS license number 
does not apply to eZ-TOMAS Remote, and will not activate it [Chapter 10 discusses eZ-TOMAS Remote]. 

If you are loading your software from a CD, the license key will be available on the Authorization Code Sheet that 
accompanied the CD, as part of your order.  If you downloaded your software from the website, your license key 
(authorization code) will be e-mailed to you within one business day. 

You will be prompted to set up your project’s security password.  When you click the <Save> button the Password 
Confirm window opens.  Retype your security password and click the <Confirm> button.  

The program’s Main window appears after your license key  is accepted. 

 

Connecting Signals 
 

WaveBook and ZonicBook Users 

Connect the analog signals to the analog input BNC connectors.  WaveBooks, ZonicBooks and the WBK14 and 
WBK18 dynamic modules require no physical hardware configuration.  Configuration is accomplished via software. 

 

Reference Note: 
Information regarding the following products is provided in documentation as follows: 

 WBK14 and WBK18 - WBK Options Manual (p/n 489-0902). 
 WaveBook - WaveBook User’s Manual (p/n 489-0901). 
 ZonicBook/618E -  ZonicBook/618E User’s Manual (p/n 1106-0901). 

 
PDF versions of the documents are included on CD, website, and are installed in the 
Programs group on your PC during software installation as a part of product support. 

 
 

IOtech 640, 650, 652, and 655 Users 

Connect the analog signals to the analog input BNC connectors.  These dynamic signal analyzers require no physical 
hardware configuration.  Configuration is accomplished via software. 

 

Reference Note: 
Information regarding 600 Series products is provided in documentation as follows: 

 640u and 650u Quick Start (324540A-01) 
 640e and 650e Quick Start  (324539A-01) 
 652uand 655u  Quick Start (324996B-01) 
 640 and 650 User’s Manual  (372160A-01) 
 652u and 655u User’s Manual (372562B-01) 

 
PDF versions of the documents are included on CD, website, and are installed in the 
Programs group on your PC during software installation as a part of product support. 
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eZ-TOMAS Order of Operation 
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A Look at the Gauge Window & Control Pull-down Menu 
The Gauge Display Window is used to show real-time values and measurement status.  Gauge Display is not used for 
historical data analysis.  The Gauge Window in eZ-TOMAS Remote looks identical, except a Server panel is included on the 
left edge of the window (see the network section of Chapter 3 for an illustration). 

The main window of the GUI (graphical user interface) includes a set of virtual gauges, which use one of 14 spectral bands, 
discussed shortly.  There will always be a vertical gauge associated with each input channel.  When the 1x Amp/Phase 
selection is made, spectral bands for “1x Amplitude” and “1x Phase” are simultaneously displayed, with the later being in a 
circular phase gauge (see second figure). 

In addition to spectral band gauge displays, eZ-TOMAS can interactively display data in a variety of other formats, 
including:  Orbit, Polar, Time, Bode, Cascade/Waterfall, Strip Chart, and Shaft Centerline.  You can control the acquisition 
through toggle switches on the lower panels or through the Control pull-down menu. 

 
  

Gauge Window Display - Various Spectral Bands 

 

Tip:  You can use the mouse to accomplish the following. 

o Double-click the left-mouse button on an area of the gauge window to access a plot display window. 

o When limit pointers are used for a vertical gauge you can use the mouse to drag them to new positions, thus setting 
new limit values. 

o When applicable, you can drag limit-lines on circular phase gauges to new positions, thus setting new values for the 
phase angle limits.  

o Right-click on an area of the gauge window to bring up a menu with several edit options (see frame A in figure).  

   Acquisition                   Limit Check                  Digital I/O              Data Storage                                       Options   
                             

Right-click on the panel to 
access the pop-up menu. 
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The data acquired by eZ-TOMAS and the supporting configuration information are stored in user-defined 
files. This allows a single eZ-TOMAS system to be used with several different machines.  The acquired 
data is stored according to user-defined event changes, e.g., alarms, time, overall, and rotating speed.   

Acquisition, instrumentation, and storage configuration parameters are also definable.  These parameters 
are stored over time.  Configuration changes do not invalidate previously acquired data. 

 

Control Pull-Down Menu’s Relation to Lower Panels  

Note:  In regard to eZ-TOMAS Remote, the following four features can be used in either monitor or controller 
mode: Lock Limit Pointers, Show Gauge Setup, Show Gauge Values, Reset Peek Hold Values.  These 
four features are “machine local” only; meaning that their use [and the results of their use] never transfers 
from client to server or from server to client. 

Acquisition 
The Acquisition Panel contains one slide switch, which determines the ON/OFF status of data acquisition.  
Turn the data acquisition ON (Up/Green), or OFF (Down/Red). 

Limit Check Panel 
The Limit Check panel contains a slide switch, an alarm log progress bar, a padlock button, and an <OK> 
button.  The Limit Check slide switch determines the ON/OFF status of the Limit Checking feature [ON is 
Up/Green; or OFF is Down/Red. 

The Alarm Log Progress Bar graphically indicates how full the Alarm File is.  The log can be accessed 
from the Display pull-down menu.   The most recent alarm event will appear below the bar. 

When there is an alarm event, channel labels will flash until the event is acknowledged.  Click on the 
<OK> button to acknowledge all outstanding alarm events.  You can right-click on a channel gauge to 
acknowledge alarm events for an individual channel.  To list alarm events for a given channel, right-click 
on the channel’s gauge, then select the View Alarm Event(s) menu option.  

The padlock button is used to lock or unlock limit pointers. 

These are the buttons from the “Options” panel 
[lower right section of the Gauge Window.  
This figure shows their corresponding menu 
selection. 
 
 
 
 
 
 
 
 
 
Double-click in this area to add notes.  Use the 
up/down buttons to scroll through the notes. 
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Digital I/O Panel 
The Digital I/O Panel contains an ON/OFF slide switch and a Relay Output Status display, which consists 
of 8 switches.   

 

If the Digital IO slide switch is turned on, Digital I/O relay switches will activate [or deactivate] depending 
on the configuration set in the Digital I/O Configuration window (detailed in Chapter 3).  The window is 
accessible via the Edit pull-menu.  

During an acquisition you can manually activate each switch by clicking on the associated button. 

 

 
Data Storage Panel 

The Data Storage Panel is easily recognized by its Snapshot [camera] button and the bar for Current Data 
Record / History File Size.  Data storage uses the First In First Out (FIFO) method of receiving and 
releasing data. 

The bar graphically indicates how full the file is.  Two numbers, separated by a slash, reside just below the 
progress bar.  In the example this is 279 / 500.   The first number is the current data record number (279 
new records); the second number is the entire number of records stored in the FIFO file 500. The number of 
new records is referred to as the History File Size.  In this case the History File Size is 279. 

Clicking the <Snap Shot> (camera) button will save “N” seconds of data to the history file; where “N” is 
defined in the User Snapshot field of the Storage Tab [in the Configuration Panel]  The Configuration Panel 
is accessed through the Edit pull-down menu.  The Gauge Window’s data storage panel includes the data 
file’s Date/Time Range.   

 

 

 

 

FIFO Records Capacity Bar 

Number of Records that can be stored (History File Size) 

 

Number of New Records 

Date/Time Range of Data File 
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Options Panel 
 

The Options Panel includes the following items.  

 

1 Show eZ-TOMAS Gauge Setup Files 

2 Display All Gauge Values 

3 Display Peak Hold Gauge Pointers 

4  Reset Peak Hold Gauge Values 

5  Display List of Network Connections 

6   Display List of TOMAS Projects 

7  Display Machine Graphic Picture 

8  Scroll through Notes    

9  Enter a Project Note 

  
The first four Option Panel items are self explanatory, that is, they are easily understood by their descriptions 
above.  The remaining five items have additional detail that now follows: 
 
Item (5), “Display List of Network Connections” relates to 
eZ-TOMAS Remote which is discussed in Chapter 10.  If you 
are using eZ-TOMAS Remote you can click on the button to 
display a list of all clients connected to the eZ-TOMAS 
server.  A few notes: (a) The button will be dim if no network 
connections are enabled.  (b) The Remote Network Connections dialog does not automatically update. To 
update the dialog box you must close, then reopen it. (c) If there is a client in controller mode, it will be 
denoted by two asterisks preceding the Remote PC ID, as shown in the second line of the example screenshot. 
 
Item (6), “Display List of TOMAS Projects,” brings up a window that lists the available .tom project data 
files that can be displayed in eZ-TOMAS.  The projects listed are those which are located in the folder for the 
current project, as well as the two folders adjacent to it.  To locate other projects you can use the File pull-
down menu, select “Open” and then use the “Look in” feature to locate available projects.  The TOMAS 
Projects widow displays the following for each project:  File, Folder, Size, and Date Modified.  To open a 
project in the list, double-click on it. 

 
Item (7), “Display Machine Graphic Picture,” brings up a selected .jpg or .bmp image to represent the 
associated machine or process being tested.  The Machine Name is defined in the Project Information Window 
(see Edit Menu). 

In regard to the graphic image, if you right-click in the window, two choices will appear: “Load graphic 
picture” and “Remove Graphic Picture.”  Clicking on the former allow you to browse your PC for the 
appropriate graphic.  Note that this can also be accomplished through the Edit pull-down menu. 

Item (9) “Enter a Project Note.” Double-click in the indicated area to enter a note.  Use the up/down arrow 
buttons (8) to scroll through the notes.  The note text, preceded by date appears in the Configuration Setup 
(tomas_Config.txt) Notepad, under Project Information, Notes.  You can access the Notepad via the Display 
pull-down menu. 

PROJECT Information ----------------- 

Company:          Cosmic Industrial 
Plant:                  Alpha Drive 
Job No.:              2387-A 
Machine 1:         33909919-A1 
Machine 2:         77890998-A2 
Note(s): 
31-May-2007      See engineering note 1.A 

Example of a Note (bottom line) as it Appears in Configuration Setup 
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A Look at the Gauges Pull-down Menu 

Most of the Gauge window is occupied by gauges which display values for spectral bands and tachometers.  
Selection of the band types can be made from the “Gauges” pull-down menu.  

The window supports up to four frames (A, B, C, D).  Each frame can accommodate up to ten gauges.   

 
Gauges Pull-down Menu 

 

You can define the parameters of User Defined bands E through N in the Spectral Bands window as follows: 

1. Open the Edit pull-down menu. 
2. Select Spectral Bands.   
3. Set the parameters of the User Defined bands (E through N) as desired. 

 
 

Additional information of primary importance to the gauge window is included in Chapter 3, which concerns 
the window’s Edit menu. 
 
 
Note:  For the IOtech 655, gauges can also be set to monitor temperature.   Gauge Display Preferences in 

Chapter 3 provides additional information. 
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Monitoring a Machine 2 

 
Using the File Pull-down Menu …… 2-1 

New (Clone) Project …… 2-1 
Initialize Project ….. 2-2 
Open Project …… 2-2 
Save As …… 2-3 
Erase History Data …… 2-7 
Erase Alarm Log …… 2-7 
Print …… 2-7 
Exit …… 2-7  

Configuring the Project …… 2-8 
Starting an Acquisition …… 2-9 
Viewing Spectral Bands …… 2-10 
Plotting Data …… 2-12 

Multiple Plots …… 2-12 
“Real Time” Plot Controls …… 2-13 
“History Data” Plot Controls …… 2-14 

Viewing Reports …… 2-15 
 

An eZ-TOMAS Project is a collection of data files, typically associated with a monitored machine.  The data files 
include configuration and measured data.  When eZ-TOMAS is activated it attempts to open the last eZ-TOMAS  
Project accessed. 

Note: If you are monitoring a machine for the first time, you should create a new eZ-TOMAS Project to store the 
machine’s configuration and vibration data. 

If you have already created an eZ-TOMAS Project for the machine, use the File pull-down menu and select 
Open to pick up where you left off.  

 

The configuration and data files have a FIFO design.  When you turn on the acquisition switch, data will be appended to 
the data files. 

 

Using the File Pull-down Menu   [In Gauge Window] 

Open Project 

Though this function is listed third on the menu list, we will mention it first here as it is frequently used and requires 
very little explanation.   The Open Project option provides a means of locating and opening an existing eZ-TOMAS 
project.  

Note: When eZ-TOMAS is started, it opens the last active project. 
 

New (Clone) Project – Creates a Copy of a Project and its Data 

Cloning a project keeps all of the values from the original project. 

   
The New (Clone) Project option opens the Save As window.  The first step in creating a new project is to select or 
create a Folder where the new project’s files should be saved.  Enter a filename for the project, then click the <Save> 
button.   

Note:  The File Menu discussed in this chapter is located 
  in the Gauge Window’s menu bar.  It is not to be     

confused with the Plot Window’s File Menu. 
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Each eZ-TOMAS Project contains eZ-TOMAS configuration and data files.  You should logically equate 
an eZ-TOMAS Project with a specific machine.  This is accomplished as follows: 

 

1. On the File pull-down menu, select New (Clone) Project.  This opens the Save As window. 

 
      Save As Window, Being Used to Create a New File 

2. Select [or create] a Windows folder for the eZ-TOMAS Project.   

3. Enter the desired filename for this project. 

4. Click the <Save> button to create the new project. 

 

Initialize Project – Creates a New Project and Sets the Number of Available Channel Inputs 

When a project is initialized you are essentially starting with a “clean slate.”  No data is carried over 
as when a project is cloned. 

To inform eZ-TOMAS as to what type of hardware will be used, select “Initialize Project” from the Gauge 
Window’s File pull-down menu.  The resulting window allows you to select a Hardware Device and the 
applicable number of input channels. 

 
 

 
 
 

If you have multiple hardware modules, and change the number of Input Channels, you 
need to use the initialize function to create a new eZ-TOMAS Project.  This needs to be 
done once, for the first implementation of the new hardware setup.  An explanation of 
how to access and use the Initialize Project function follows. 
When a project is initialized you are essentially starting with a “clean slate.”  No data is 
carried over, as would be when a project is cloned. 

 

“Initialize Project” is accessed from the File pull-down menu.  Initialize Project provides a means of 
selecting the hardware device and setting the number of input channels.  For example: If you had an 8 
channel Medallion and were going to change your acquisition to 24 channels, for example, using a 
ZonicBook/618E and two WBK18 modules, you would need to use the Initialize Project feature. 
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Complete the following steps to initialize a project.  Note that the step numbers correspond to the numbers 
in the figure. 

1.  From the File pull-down menu, open “Initialize Project.”  An Initialize Project dialog will open. 

2.  Select the Hardware Device (e.g. 640u, ZonicBook/618E)  from the associated pull-down list. 

3.  Select the number of analog input channels from the associated pull-down list.  For 
ZonicBook/618E do not count the separate tach channels as input channels. 

4.  If applicable, enter and confirm the project password. 

5.  Click the <OK> button. 

Note that the last section of the preceding chapter illustrates an example for 24 channels. 

 

 

Depending on the data acquisition hardware, eZ-TOMAS will automatically enable gauges 
for the first 8 or 10 channels.  If your device has more channels that you want to display you 
will need to enable them manually using the Gauge Display Preferences window (accessed 
via the Edit pull-down menu).  From the Gauge Display Preferences window, ensure there is 
a checkmark in the “Visible” column for each channel that you want to display.  Remove 
the checkmark for those you don’t want to display.  The window is discussed on page 3-21.  

 

Save As 

The Save As option allows you to backup history files in a binary file format, or export files in an ASCII 
file format.  This command opens the Backup/Save eZ-TOMAS Project window. The options in this 
window change as you make selections. You can backup and export full or partial files.  

Note: The disk space required to backup the selected records is displayed on the left panel. 
 

Entire Project 
The Entire Project option is only available when data 
acquisition is turned off.  Entire Project performs a file copy 
operation to the specified Windows Directory.  This backup 
method is the fastest.  

 

 

Save As… Entire Project 
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Partial Project 
The Partial Project option can be used when data 
acquisition is active.  This option copies data and the 
configuration setup to the designated folder for the 
date and time range specified in the panel on the right.  

To make a partial backup: 

1. Select the range you want to backup [see next 
section, Selecting Range Limits]. 

2. Click the <Save> button.  The Save As window 
will open. 

3. Select the folder where the file is to be saved. 

4. Enter a filename. 

5. Click the <Save> button. 

 

Save As… Partial Project 

Selecting Range Limits 
For each backup format, with exception of “Entire Project,” you will need to select the start and stop points 
to define the range of data.  This section explains how to use the Date/Time panel to set the range. 

o Button <A> [in the following figure] resizes to the default history range. 

 
o Button <B> zooms in on the history range.  This affects the view, not the range.  After clicking on 

the button, put the mouse cursor at a point on the screen where you want the viewing area to begin 
(such as B1 in the figure) and drag the mouse to the desired zoom end-point (for example, B2).  We 
have used a yellow band to show what would be in the new viewing area.  Note that clicking 
button <A> would now reset the range. 

o Numeric fields “C” and “D” allow you to enter range start and stop points.  In the example these 
are 83 and 199.  Note that the displayed Date/Time/RPM information changes to reflect the 
associated range end-point as you move the green or red limit band. 

o “Drag Method E” You can place the mouse cursor over the green (start) and red (end) limit 
bands, and then use the mouse to drag the selected band to a new range point. 

o Click the <Save> button once you have selected the desired range. 

 

Reset 

Zoom-in 
 
Start point 

End point 

Drag Method “E” 
Place mouse cursor over 
a band, then hold left 
mouse button down to 
drag the limit band to a 
new location. 
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Backup Format – Spectral Bands (ASCII) 
This option creates an exportable ASCII file for the spectral band data that resides within the specified 
Date/Time range.  

   
 Save As… Spectral Bands (ASCII) 
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Backup Format – Time History Data (BUNV) 
This option creates an exportable Binary Universal  
(UFF-58B) format (BUNV) file for the 
Time History data that resides within the specified 
Date/Time range.  

 
 

 

 

 

 

 

 

 

 

 

 

 

BackUp Format –  Time History Data (ASCII)  
 You can save time history data in ASCII format.  
Select the: File-Save As menu option, then Click 
on the Time History Data (ASCII) menu option.  
 
 
 

NOTE:   
 

This option can result in 
relatively large files. 

 
 

Save As… Time History Data (BUNV) 
 

Save As… Time History Data (ASCII) 
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EZ-TOMAS 5.5.09 
ASCII Time Waveform Data Report generated 30-Aug-2006 11:15:01 
Project Path: J:\Tomas Software\Data\Unit #2 Pre Outage\Ops Duwn 92603 
 
Start Date:   26-Sep-2003 22:39:13 
End Date:     26-Sep-2003 22:43:00 

 
Sampling Rate:  1280. samples/second 
Delta Time:     0.00078125 seconds 

 
1. Brg 1Y mils 
2. Brg 1X mils 
4. Brg 2 "X" mils 
 
Date / Time  mSec Sample Time Waveform Data 
 
26-Sep-2003 22:39:13 190 1 0.1830 -1.014 1.362 
26-Sep-2003 22:39:13 190 2 0.6764 -1.136 1.266 
26-Sep-2003 22:39:13 190 3 1.131 -1.195 1.460 
26-Sep-2003 22:39:13 190 4 1.456 -1.136 1.793 
26-Sep-2003 22:39:13 190 5 1.702 -0.9803 1.991 
26-Sep-2003 22:39:13 190 6 1.773 -0.8245 1.996 
26-Sep-2003 22:39:13 190 7 1.729 -0.6158 1.920 
26-Sep-2003 22:39:13 190 8 1.580 -0.3180 1.988 
26-Sep-2003 22:39:13 190 9 1.288 -0.1010 1.878 
26-Sep-2003 22:39:13 190 10 0.8858 0.1411 1.709 
Etc… 

 

 

Erase History Data 

 

Use the Erase History Data option with caution.  This 
menu item will erase History Data for the project.   All 
data for the active project will be permanently removed.  
It is not recoverable. 

 

Warning for Erase History 

 

Erase Alarm Log 

 

Use the Erase Alarm Log option with caution.  This 
menu item will erase the Alarm Log file for the project.  
It is not recoverable. 

 
Warning for Erase Alarm Log 

 
Print 
 

“Print” brings up the Print Window for printing the current screen. 
 

 
Exit 
 

Closes the eZ-TOMAS application. 
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Configuring the Project 
A default configuration is automatically loaded when you open an eZ-TOMAS file.  However, you may 
want to make some changes to the configuration.  To make changes: 

1. From the eZ-TOMAS Main Window, open the Edit pull-down menu. 

2. Select Project Information to open the associated window (following figure).  Update 
information and/or add notes as applicable. 

 

 
Project Information Window 

 

3. After the Project Information is as desired, click the <OK> button.  

4. In the Edit menu select Configuration.  The Setup Configuration window will appear 
(following figure). 
 

 

Reference Note: 
The four tabs of the Setup Configuration window are labeled: Acquisition, Input Channels, 
Spectral Bands, and Storage.  They are discussed briefly in this section and in detail at the 
beginning of Chapter 4, Edit Menu. 
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5. Make sure that the Hardware panel reflects the correct device, e.g., ZonicBook/618E.  

 
Setup Configuration Window, Acquisition Tab 

  
 

 
 
 

Clicking the <Cancel> button will undo all the changes you’ve made since you 
opened the Setup Configuration Window. 

6.  Make the desired changes for each of the tabs and then click the <Save> button.  

You can start monitoring immediately. 

Acquisition Tab – From the Acquisition tab you can set up parameters that include, but are not limited 
to:  Block Size, Analysis Frequency, Low Cutoff Frequency, FFT Window, and Number of Averages. 

Input Channels Tab – From the Input Channels Tab you can change channel parameters.  This 
includes, but is not limited to assigning channel types, customizing channel names, setting the instrument 
range per channel, and assigning units. 

Storage Tab - From the Storage Tab you can specify how you want trigger data storage.  If any one 
event is triggered, data from all channels is stored.  Data storage events are triggered when a change occurs 
in the monitored machine’s condition.  The basic idea is to activate storage based on Time Change and/or 
Speed Change and/or Amplitude Change. 

Refer to Chapter 3 for more information regarding the Setup Configuration tabs. 

Starting an Acquisition 
After you configure your eZ-TOMAS Project, click the <Acquisition> Switch to place it in the ON (green) 
position.  This starts the data acquisition.  The switch is located in the in the lower left corner of the eZ-
TOMAS gauge window. 

When acquisition is active, real time overall values are displayed in the instrument gauges.  

To stop data acquisition, click the switch.  It appears in the slide-down position for OFF (red). 
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Viewing Spectral Bands 
You can set spectral band options from the Main Gauge 
Window.  There are several methods of setting gauges; 
these are discussed below.   

In the partial gauge window at the right, we see five gauges 
with spectral bands selected as follows, from left to right. 
 

1. DCGapV. Vdc 
2. 1xAmp: mils (p-p) 
3. 1xAmp: mils (p-p) 
4. DCGapV: Vdc 
5. Overall: mils (p-p) 

 
We can change the spectral band for each gauge, 
independently; or we can make a global change – where we 
would apply the same spectral band to all gauges at once. 

 

 
 
 
To set a gauge independent of other gauge settings: 
 

1. Right-click in the applicable gauge. 
2. Select “Spectral Band.” 
3. Select the desired band type. 

(See second figure)  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
Open TCs and Open IEPE 
 
Open temperature and open IEPE channels are indicated  
by a blue gauge label.  In the figure to the immediate right  
we see that “Temp Ch 4” has a black gauge label which is   
indicative of a normal (closed) connection.  “Temp Ch 5,”  
however, has a blue gauge label, which indicates that the  
associated thermocouple is open.  
  
Note that the example at the right is from an   
IOtech 655u which includes five temperature  
channels. 
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To set all gauges to the same type of spectral band, i.e., to 
make a global change: 
 

1. Open the Gauges pull-down menu. 
2. Select the band of interest. 
 
As soon as step 2 is performed, all gauges will change to the 
selected spectral band. 
 
Note: Selecting 1x Amp/Phase or 1x Phase/Amp results in 

two gauge types.  In both of these instances, a vertical 
gauge will display for 1x Amplitude and a circular 
phase gauge will display for 1x Phase.   

 
  

 

To set all gauges to a previously established set of 
gauge settings: 
 
You must first have one or more saved gauge setup files.  
When you have a setup that you believe you will use 
frequently, open the Gauges pull-down menu and select 
“Save Gauge Setup.”  In the “Save As” window that 
appears, select a Filename and a location.  Then save the 
.tgs file. 
 

 

You can either: 

(a) use the Gauges pull-down menu and select 
“Recall Gauge Setup” or  

(b) click on the <Show eZ-TOMAS Gauge Setup 
Files> button. 

  
You can also affect the Gauge Window from the Edit pull-down menu.   
 
Selecting “Gauge Preferences” opens an associated window.  See following figure.  From there you can drag a desired 
spectral band type over to a specific gauge. The Gauge Preferences window is discussed in detail in Chapter 3, Edit-menu. 
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The “Spectral Bands” selection in the Edit-menu opens up a window which resembles the following.  Making changes in this 
window will impact the Gauge Window. 
 
Refer to Chapter 3 for details on this and other aspects of the Edit menu. 
 

 

 
 

Plotting Data 
Click on “Display” in the main window’s menu bar, then select “Plot Windows.”  The Data Display 
Window will open.  Note that you can double-click on a gauge to open the Data Display Window to plot 
data for that specific channel. 

Multiple Plots  

1. On the second row of the Plot Windows toolbar, click the 
<Open New Plot Window> button (see figure).  This opens a second 
display window.  As an alternative to using the button you can open a 
new Window from the Window pull-down menu. 

2. On the Window pull-down menu of the Plots window, select either 
Tile Vertically or Tile Horizontally. 
 
All display windows will be shown simultaneously. 

3. Select the Channel(s) and Display type for each window. 
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Time Display and Spectrum Display Plots Tiled Horizontally 

Each plot is longer in the horizontal direction. 

 

A cursor is provided with each display. To move the cursor, place your mouse icon over the cursor and 
drag it to the desired location on the trace or use the East / West Arrows. 

 

 

“Real Time” Plot Controls 

“Real Time” is the default data source.  For Real Time displays you can Halt and Resume the display of 
data by using the <Pause/Continue> toggle button (see following figure).  As an option to the <Pause/ 
Continue> button you can use the “P” key on the PC’s keyboard.  A table, which identifies all control 
buttons follows shortly. 

The <Clear Real Time Plot Buffer> button, which looks like a black “X,”allows you to clear the data in 
the realtime trend displays.  This display option can be used to clear the plot displays prior to starting a 
test.  
 

Selects 
Real Time 
Mode 

Pause/ 
Continue 

Clear Real Time 
Plot Buffer 

 
Real Time Mode is Selected 

 

 

Reference Note: 
Refer to Chapter 6 for more detailed information regarding Plots and the associated toolbar 
buttons and other controls. 
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“History Data” Plot Controls 

When viewing History Data (pre-recorded data files), you can use the set of playback buttons or the slider 
bar to navigate through the data.  A table, which identifies all control buttons, is included in Chapter 6.  
Note that the playback buttons and slider remain hidden in the GUI when eZ-TOMAS is in the Real Time 
mode. 

History Data is accumulated according to the parameters setup in the Setup Configuration window’s 
Storage Tab, which is accessed via the Gauge Panel window’s Edit Menu. 

 
 

 Data Source- 
History File 

Play Back 
Buttons 

Record      Record / Total 
Pointer 

Playback 
Update Rate 

   
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Reference Note: 
Refer to Chapter 6 for more detailed information regarding Plot displays, 
associated toolbar buttons, and other controls. 

 

Resize to the 
default range. 
 
 
Zoom in on the 
History range. 
 
 
Set range 
starting record. 
 
Set range 
ending record. 
 
 

Show 
Alarm Log 
 
 
 
Show Snapshot 
Log 
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Viewing Reports 
 

eZ-TOMAS can generate the following types of reports, which are accessible from the Display pull-down 
menu.  

Display Pull-down Menu 

 

The Statistical Report lists the historical spectral band data.  It includes the instrument, the engineering 
units, the minimum value, the mean average value, the maximum value, and the standard deviation by 
channel.   Statistical reports can be used to automatically generate limit values based on historical data. 

The Alarm Log is a record of the last “N” number of alarm events.  The number of alarms was specified in 
the Setup Configuration window under the Storage Tab.  The Alarm Log includes the date and time, the 
channel number, reference tachometer, instrument name, spectral band type, alarm type, and value of the 
alarm signal.  

The Snapshot Log can be accessed from the Reports pull-down menu, or from the History Data Window.  
The Snapshot Log file contains entries which were created whenever the user clicked the <Snapshot> 
button, which is located in the Gauge Window’s Data Storage panel. 

The Production Test Report.  The feature allows you to generate a custom report, which can include the  
company logo or other graphic, such as a machine image. The Production Test Report application is 
primarily used by manufacturers, as it summarizes the results of each tested machine state in an easy-to-
read report.  The feature uses Microsoft Excel 2000 (version 9.x) or later. 

Selecting Configuration Setup from the Reports pull-down menu creates a text file that contains 
configuration details of the current project. 

 

 

 

Reference Note: 
Refer to Chapter 6, Display… Reports, for detailed information regarding each report type and 
for instructions pertaining to generating limits. 
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Edit Menu   [In Gauge Window] 3 

 
Project Information… (Ctrl+M)  …… 3-1 
Configuration… (Ctrl+E)  …… 3-2 

Acquisition Tab…… 3-2 
Input Channels Tab …… 3-3 
Tachometer Notes ….. 3-10 
Synopsis of Tach Modes …… 3-11 
Storage Tab …… 3-12 

Spectral Bands… (Ctrl+B)   …… 3-14 
Spectral Limits… (Ctrl+L)  …… 3-17 
Digital I/O…… 3-20 
Gauge Display Preferences… (Ctrl+G)  …… 3-21 
Plot Display Preferences… (Ctrl+D) …… 3-21 
Function Key Preferences …… 3-23 
Server Configuration… (Ctrl+R)   …… 3-24 
Copy Window… (Ctrl+C) …… 3-24 

 
 
Note:  The Edit Menu discussed in this chapter is located in the Gauge Window’s menu bar.  

It is not to be confused with the Plot Window’s Edit Menu. 
 

 

Project Information… (Ctrl+M)              Edit Menu 
 

 
 

The Project Information window allows you to add general details to the eZ-TOMAS project: Company, 
Plant, Job Number, and up to 8 alphanumeric Machine Names.   Up to 10 user notes [each up to 256 
characters] can be added to each project.  Double-click in a text field to add or edit information. 

The information in this window can be added to analysis displays as plot annotation, which can be useful 
when generating reports. 
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Configuration… (Ctrl+E)              Edit Menu 
This opens the Setup Configuration Window, which has three separate tabs for configuring the acquisition 
device. Click the appropriate tab [Acquisition, Input Channels, or Storage], make the necessary changes in 
each, then click the <OK> button to save all your changes and close the window. 

 

 
 
 

Clicking the <Cancel> button will undo all unsaved changes.   
You must turn acquisition off and then on again for Acquisition Configuration 
changes to take effect. 

 Acquisition Tab 

 
 Acquisition Tab 

The Acquisition tab is used to configure how the data will be acquired and processed.  For eZ-TOMAS, 
sampling rate and through-put rate are determined by two user-set parameters:  Analysis Frequency 
and Spectral Lines.  The following table shows parameter relationships.  Information was obtained from 
the above screen-shot. 

Parameter Calculation (based on above Acquisition Tab) 

Sampling Rate 
=  Analysis Frequency x Nyquist Factor 

=  500 Hz x 2.56 
=  1280 samples per second 

The sampling rate applies to 
ALL input channels. 

Time Resolution  
=  1 / Sampling Rate 

=  1 / 1280 samples per second 
=   0.000781 seconds 

Acquisition Time 
 =  Spectral Lines / Analysis Frequency 

=  800 Lines / 500 Hz 
=   1.6 seconds 

Frequency Resolution 
 =  Analysis Frequency / Spectral Lines 

=  500 Hz / 800 Lines 
=   0.625 Hz 

Block of Time Data 
= Spectral Lines x Nyquist 

=  800 x 2.56 
=   2048 samples  
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Panels of the Acquisition Tab 
 

Hardware 

 

The Hardware Panel has a pull-down list from which the applicable 
data acquisition device must be selected. 

 

Startup State  

 

Used to set the default startup state for the Project's Acquisition, Limit 
Checking, and Digital IO processes.    eZ-TOMAS will turn on the 
selected processes when the project is opened. 

 

 

dB Reference 

 

This panel is used to set the 0 dB reference point in Engineering Units 
(EU).  The EU value for 0 dB reference is used with microphone input 
channel types.  The default setting is 20 micro-Pascals (0.000020 pa). 

 

Acquisition 

 
 

 

 

 

 

 

 

Analysis Frequency (Hz)  The maximum frequency of interest.  The 
sampling rate will be 2.56 times the analysis frequency.  Verify the 
maximum frequency response of your probes.  For a Tach signal, 
your Analysis Frequency should be a higher multiple of the maximum 
rotating speed.  Typically, this multiple is at least 10 times the rotating 
frequency. 

Spectral Lines  The number of lines per spectrum and the number of 
data samples used in the FFT (Fast Fourier Transform) process.  The 
more spectral lines, the greater the data resolution.   As the number of 
spectral lines increases, so does the time that it takes to collect the 
data and the amount of disk space. 
Overlap Data Acquisition  For slow speed data acquisition 
applications, you have the option to select overlap data processing to 
speed up real time data displays.  This option is enabled when the 
Acquisition Time is greater than 2 seconds. 
  
If you select Overlap Data Acquisition, eZ-TOMAS will automatically 
determine the overlap percentage needed to achieve a 1 to 2 second 
display update rate.  For example, if your analysis frequency is 
500 Hz and you have 3200 spectral lines, the acquisition time is 6.4 
seconds.  With Overlap Data Acquisition, the overlap percentage will 
be 75% and the update rate will be 1.6 seconds.  (6.4 sec / 4).  The 
divisor is a power of 2. 
  

Number of Averages  The number of data blocks averaged before a 
block of data is accepted and displayed.  Typically, the value is “1” 
indicating no averaging. 

FFT Window  Fast Fourier Transform.  FFT is an efficient technique 
for calculating the frequency of components in a time-domain 
waveform based on digitized voltage measurements.  The result is a 
display of amplitude versus frequency and phase versus frequency.  
The FFT Window is a weighting window, typically either Hanning or 
Flat Top. Hanning provides better frequency resolution. Flat Top 
provides better amplitude resolution. 
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Note:  Filter Panel options apply to ZonicBook/618E and WBK18 channels.  
 

High Pass AC Coupling Filter (Hz) 

 

High Pass AC Coupling Filter:  When AC Coupling is selected in 
the Input Channels tab, the associated input signals will pass 
through a 0.1 Hz or a 1.0 Hz High Pass Filter, depending on which 
radio button is selected. 

IEPE Delay Time - The typical IEPE charge time for a 0.1 Hz AC 
coupling filter is 40 to 60 seconds, and 4 to 6 seconds for a 1.0 Hz 
AC coupling filter.  While the IEPE is charging, you will see large DC 
offsets in the acquired data. 

For this reason you may want to enter an IEPE Charge delay time.  
eZ-TOMAS will pause data acquisition and storage for the indicated 
time period.   

 

Acceleration – Velocity – Displacement Preferences 

 

Accelerometer and Velocity signals can be integrated.  Select the 
desired integration units from the Engineering Units pull-down list.   
The High Pass Display Filter applies to the frequency displays and 
calculations, such as the Overall Vibration Level.  The filter values 
(Hz) can be defined for each integration type.  Frequency data below 
the set filter value is zeroed.  This is useful when you want to remove 
the “Ski-Slope” effect of integration. 
Important

For related information, see INT/DIFF on page 3-

:  Make sure the Filter Value is lower than the Machine 
running speed, by at least 50%.   
Example:  For a running speed of 1200 RPM we would need to 
set the filter value to 10 Hz or lower. Calculated as follows: 
0.5(1200rev/60sec) = 0.5(20rev/sec) =  10Hz  

7.  

 

Scale Preferences 

 

The instrument scale preferences can be defined for Acceleration, 
Velocity, and Displacement input types.   
 
You can select one of the following for each of the three instrument 
types:   
 

RMS 
 
Peak (PK) 
 
Peak-to-Peak (P-P) 
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Terms and factors related to the Acquisition Panel 

Nyquist Factor  Nyquist Factor – The nyquist factor is a representation of the anti-aliasing cutoff 
frequency and is equal to the anti-aliasing cutoff frequency divided by the sample 
rate.  In eZ-TOMAS, the analysis frequency is multiplied by a nyquist factor of 2.56 
to obtain the sampling rate. This ensures that a sampled analog signal is accurately 
represented.   

Sampling Rate The rate at which the signal is sampled.  For eZ-TOMAS, the sample rate is always 
2.56 times the Analysis Frequency. 

Spectral 
Resolution 

A value related to Analysis Frequency and Spectral Lines.  Where Spectral 
Resolution equals the Analysis Frequency divided by 2.56.  If the Analysis Frequency 
was 1000 Hz and if the Spectral Lines was 800 lines; then the Spectral Resolution 
would be 1.25 Hz per spectral line.   (1000 Hz / 800 = 1.25 Hz) 

 

Input Channels Tab 

This tab is used to configure each channel for your project.  The available setup options in this window are 
dependent on the instrument type selected; for example, the IOtech 655 can measure temperature and the Input 
Channels tab will display columns associated with Thermocouples, RTDs, and units in degrees (second figure). 

 
Input Channels Tab, Scrolled Left - Showing the Leftmost Column 

 

 
Partial Input Channels Tab,  Showing temperature related columns for an IOtech 655. 
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Input Channels Tab, Scrolled Right - Showing the Rightmost Column 

 
To configure a channel: 

1. Select the channel to be configured. 
2. Set the instrument type. 
3. Set the value for each attribute of the channel. 

Repeat this process for each channel.  

 

The parameters of one channel can be copied to another channel by using 
options on the Edit menu. 

 

Input Channels Tab Column Functions 
No. is the channel number.  Selecting the channel number highlights all attributes for that 

channel. 

Type is the type of instrument attached to the channel. Options are: 

 o Accelerometer 
o Velocity 
o Displacement 
o Static 
o Tach 

o Microphone 
o Pressure 
o General 
o Unused (select “Unused” for channels that 

have no instrument attached.) 

Name is a Label you will use to identify the channel. 

Gauge Min, 
Gauge Max 

represent the instrument range minimum and maximum gauge values. 

Units the Engineering Units label you want to use.  
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INT/DIFF This column is used for setting a single or double integration, or a single or double 
differential.  It can be used for the following three types: Accelerometer, Velocity, 
Displacement.    
Note that the integration value (g’s/ips/mils, g’s/ips/in, or g’s/mmps/mm) is selected in 
the Acquisition Tab. 
Possible INT/DIFF column selections for Accelerometer, Velocity, and Displacement are: 

 Accelerometer Velocity Displacement  

 None 
Single Integration 
Double Integration 

None 
Single Integration 
Single Differential 

None 
Single Differential 
Double Differential 

 
 
 

Comments:   
(1) If the signal is acceleration

(2) If the signal is 

, then single integration results in velocity; and 
 double integration results in displacement. 

velocity

(3) If the signal is 

, then single integration results in displacement; and 
single differential results in accelerometer. 

displacement

mV / EU 

, then single differential results in velocity; and 
double differential results in accelerometer. 

is the instrument sensitivity.  (Typical displacement probes: 200 milli-Volts per mil.  
Typical accelerometer probes: 100 milliVolts per G.  For Tach probes  
enter 1000.) For static channels, this property represents the slope variable (m) of the 
linear equation y = mx + b. 

Offset Sets the offset factor that is to be applied to the Engineering Units. 
 

FSV FSV (Full Scale Voltage) is the maximum input voltage for the instrument.  If you are 
unsure of the instrument’s maximum voltage value, select a high voltage value. 

 
IEPE A constant bias current is available for IEPE (ICP) transducers that are used as signal 

input for many IOtech devices.  The bias current is sourced through the center conductor 
of the input channel BNC connector and returns to the analyzer via the BNC’s outer 
conductor.   Consult your hardware manual for applicability.   

The current source features an operating compliance voltage (see product specifications) 
and is protected in regard to both short-circuit and overvoltage.  Operating compliance 
refers to the highest voltage that can be applied without change of the current source 
value.   In the absence of a transducer, the current source will output an open circuit 
voltage.  For applications that do not require bias, the current source can be disconnected 
from the input by un-checking IEPE in the Input Channels tab on a per-channel basis. 

When the IEPE cell is checked for a channel, the current source is enabled and the input 
voltage is continuously monitored with level detection circuitry.  Recognition of a voltage 
slightly greater than compliance voltage (transducer open) or a very low voltage 
(transducer short) triggers a transducer fault condition for the affected channel.  When the 
IEPE function is not available to a channel a dash appears in the IEPE column of the 
associated channel. 
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Coupling Each input can be AC or DC-coupled.  The AC-Coupling High Pass Filter selection is 
located on the Acquisition Tab.  Proximity and Static Probes are typically DC-coupled.  
All other types are usually AC-coupled.  AC-coupling can be set to a high pass filter value 
of 0.1 Hz or 1 Hz.  The value is selected in the Edit Menu’s Acquisition Tab.  Note that 
when DC-Coupling is selected the high pass filter is bypassed.  
When the Coupling function is not available to a channel, or not used by a channel, a dash 
appears in that channel’s Coupling column. 

 
 

[Probe] 
Location 
L / R 

The probe location and L/R columns are used to define 
the physical angular location of a probe, from 0° to 
180° left or right of Top Dead Center (TDC).  The two 
columns are in the Input Channels tab, as indicated in 
the figure below.  Probe location is used for Orbit, 
Polar, and Shaft Center Line displays.   
Note:  Orientation of view is looking from the Driver 
to the Driven.  Zero degrees is always given as top 
dead center (TDC).  With eZ-TOMAS versions 5.5.09 
and higher, the probe location is defined as “N” 
degrees Left or Right of TDC.  Projects created in 
earlier versions of eZ-TOMAS defined location as 
being CCW from TDC.  That convention is 
automatically converted to the newer one, represented 
in the figure at the right. 
 

 

 
 

1xA Ref and  
1xP Ref 

1x Amplitude Reference and 1x Phase Reference are the slow roll values used for Runout 
Compensation on Bode, Polar, Time Waveform, or Orbit displays. 

Gap Volt  is the DC voltage value when the shaft is at rest.  This value is used for Shaft Center Line 
displays. 

 
XY Pair XY Pair associates 2 probes on a bearing.  Typically, probe pairs are located 90 degrees 

apart.  Orbit and Shaft Centerline displays require a Channel Pair. 

Brg Clear Bearing Clearance is measured in the instrument’s engineering units.  You can 
optionally overlay the bearing clearance circle onto an orbit display or shaft centerline. 

Brg Start Bearing Start is the location of the shaft relative to the bearing when the machine is at 
mechanical rest.  Three possible locations are taken into consideration: Bottom, Center, 
and Top.  For horizontal shafts, a bearing start of bottom is typical, due to gravity; 
However, in some situations mechanical linkage can result in a bearing start with the shaft 
at the top.  For shafts that are oriented vertically, a bearing start of center is likely. 

Tach 
Reference 

This column defines allows you to define a reference tachometer for each channel.  Thus, 
on Gauge Display and Plot Display eZ-TOMAS  can show 1x values relative to the 
preferred tach.  When two or more tachs are defined eZ-TOMAS computes spectral data 
relative to each.  For example, with two tachs: If Tach 1 measures 3000 rpm and Tach 2 
measures 4500 rpm eZ-TOMAS computes 1xA values for each.  With the RPMs given, 
the resulting  1x Frequency values are 50 Hz for Tach 1 and 75 Hz for Tach2.   
 
Clicking the Tach Reference column brings up a pull-down list which indicates the 
tachometer channels available for use as reference [for the currently displayed data]. 
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Tach Section of the Input Channels Tab 

Rotation is the shaft’s rotation direction, either clockwise or counter-clockwise.  The direction 
indicated is as viewed from the driver end of the machine train. 

Pulse/Rev is the number of pulses per 360 degree revolution. (Default: 1) 

RPM Mult. Used to enter an RPM multiplier value.  This is useful if your tachometer is measuring an 
RPM that is proportional to another value of interest, such as in a gear train.  For 
example, you want to see the RPM for shaft “X” which is known to turn at 2.5 times the 
RPM of gear “Z;” but it is impractical for a tachometer to measure the RPM of the shaft 
by any direct means.  In this case, we would enter a multiplier of 2.5 for the gear’s RPM 
to obtain the shaft’s RPM. 

Auto Tach If a Analog Input Channel is defined as a Tachometer Input.  You can either manually 
specify a trigger level or use the Auto-Tach detection option. 
  
During acquisition eZ-TOMAS can automatically detect and adjust the analog tach’s 
trigger settings.  This can be useful when the tach signal changes voltage levels during 
machine operation. 

Trig Dir is the “negative’ [down arrow] or “positive” [up arrow] direction of the moving shaft. 

Trig Volt defines the Tach pulse for tach signals.  A keyway will generate a Negative Tach pulse.  
Typical Tach signals will generate at least a 1 V pulse.  You can check the voltage value 
using a Time display. 

Mode Used to select one of three available modes: Voltage, Counter, or Period. 
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Tachometer Notes 
To Assign a 
Tachometer to a 
Channel 

1. Navigate in eZ-TOMAS as follows:  Edit [pull-down men] \ Configuration \ 
Input Channels Tab \ Tach Reference column. 

2. Click in the Tach Reference column and select the desired tachometer from 
the pull-down list. 

To Edit a 
Tachometer 
Channel’s 
Parameters 

1. Navigate in eZ-TOMAS as follows:  Edit [pull-down menu] \ Configuration \ 
Input Channels tab. 

2. Edit the parameters on a column by column basis, as desired.  Note that there 
are two places from which you can edit tachometer parameters: 
(a) The main area of the Input Channels tab.  This is where, for a Tachometer 
type, you can edit the tachometer channel’s name, minimum and maximum 
gauge values, units, etc. 
(b) The lower panel of the Input Channels tab.  From here you can configure 
the tachometer channel’s rotation (CW or CCW), trigger/revolution, trigger 
direction (POS or NEG), and trigger voltage. 
For applicable illustrations of the channel configuration areas, refer to the 
preceding two figures. 

To obtain 
optimal noise 
rejection 

1. Setup the input for Voltage Mode. 

2. Take a measurement. 

3. View the Tach Signal on a TimeWaveform plot. 

4. Set the Trigger Slope [Trig Slope] to Positive (POS) or Negative (NEG). 

Using Analog 
Input as a Tach 

1. If you connect a tachometer sensor to an analog signal input channel (CH1 
through CH8) [instead of to a dedicated tach channel], the tachometer modes 
will not be applicable to that channel. 

2. Tach calculations [using an analog input] automatically remove offset.  For 
this reason you must specify the tach trigger voltage [for the tach channel] as 
though the channel was AC coupled. 

3. Though offset is automatically removed, it can be displayed using DC 
coupling. 

4. The gauge max value [for an analog channel used as a tach] is used to ignore 
spurious tach pulses, i.e., anything above the gauge max value.  For this 
reason care must be taken to set the max gauge value correctly when any 
analog channel is used as a tach. 
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Synopsis of Tach Modes 
When you connect a tach sensor to a tachometer designated connector, such as the ZonicBook/618E’s 
TACH BNCs (TACH1, TACH2, TACH3, or TACH4) you can select one of the following three modes:  
Counter, Period, or Voltage.  

 

If tachometer triggers will occur at a rate greater than or equal to the 
“scan rate divided by 10” then the Period Mode must be used. 

 

Counter Mode 

 
 

Counter Mode generates a Pulse of Amplitude “+1” for each tach 
trigger.  The counter mode can be used when the number of 
pulses is less than the scan rate divided by ten (< scan rate / 10).   

Once you have established the phase relationship of a machine 
running near optimum, the observance of phase shifts can be 
used to signal the development of a mechanical problem. 

 

Use Counter Mode when Pulses per 
Revolution are needed. 

Counter Mode can be used for phase 
shift observance. 

Period Mode 

 
 

The period is the time from the rising edge of one pulse to the 
rising edge of the next pulse, or the time from the falling edge of 
one pulse to the falling edge of the next pulse.   

The Period Mode is used for Tachometer inputs which exhibit 
multiple pulses per revolution.  The mode provides accurate 
overall RPM without sacrificing scan rate.  Phase measurements 
are not possible when using period mode. 

Note: 60 seconds divided by the period [in seconds] equals 
RPM. 
 

Use Period Mode when multiple 
pulses are involved, such as from gear 
teeth. 

Period Mode cannot be used for 
phase shift observance. 

Voltage Mode 

 

Voltage Mode is used for Tachometer inputs to view actual input 
voltages from the Tach Sensor.  This mode is useful for locating 
an ideal Tach Trigger Voltage setting, i.e., one that is in a clean 
region of a leading edge, as illustrated.   

Notes: 
1) Voltage mode cannot be used for phase measurements 

between analog inputs and tachometer inputs. 
2) When in voltage mode, a displayed hardware tach 

channel will always show existing offset, if present. 
3) When specifying the voltage for a hardware tach 

trigger, consider whether the channel is AC or DC 
coupled. 
 

Use Voltage Mode when you need to 
determine a trigger voltage. 
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 Storage Tab 

 
Storage Tab 

Basic Description 
Data storage is activated by trigger events.  If any one event is triggered, data from all channels is stored.  
Data storage events are triggered when a change occurs within the range of your defined parameters.  An 
example follows the parameter definitions. 

Note:   For Static Input Channel types (selected in the Input Channels “Type” column)  
eZ-TOMAS calculates and stores the averaged value in the time block.   

 

Panel Description 

History FIFO 
 
 

Displays the number of storage records in the History FIFO (First-In-First-Out) file.  
Based on the configuration, values for both the required and the available disk space 
are shown.  The panel includes a checkbox to enable backing up the project.  If the 
project backup feature is enabled, the backup files will be stored in your EZ-TOMAS 
project folder.  They will have the same file name, followed by an underscore and a 
number; for example, the first backup of a file called: TurbGen.tom would be 
TurbGen_1.tom. 

RPM Range   The speed range in which data storage is permitted. 

RPM Change  An RPM-based trigger for the storage of data.  Data will be stored when the machine 
speed changes by the specified RPM value.  To enable the delta RPM storage trigger 
check the “Enabled” checkbox and enter an RPM value.  

Time Change A time-based trigger for the storage of data.  Enter the number of seconds, minutes, 
hours, or days between desired storage events.  To enable the time-based trigger 
check the “Enabled” checkbox. 

Overall Change An amplitude-based trigger that can be defined for each channel.  Data is stored when 
the overall amplitude changes by the specified value.  The user must check the 
“Enabled” box for each channel that is to be used as an overall change trigger. 
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User Snapshot Used to specify the duration of continuous data gathering (in seconds) for a snapshot 

of data.  When the snapshot button is clicked [the button with the camera image], data 
will be collected for the specified duration. 

  
The history file is a FIFO file.  You can define the depth of the history file; however, the amount of time 
needed to fill the file depends on the trigger event values.  The smaller the trigger values, the faster the 
history file fills.  The current data storage status is shown in the Main Window. 

 

Example 
Assume that a motor typically runs at 3600 RPM and we would like to store data when the motor is running 
above 200 RPM and below 5000 RPM.  

1. Open the Edit menu. 

2. Select “Setup.”  The Setup Configuration window will open. 

3. Select “Storage Tab.” 

4. For RPM Range enter a value of 5000 for the maximum and 200 for the minimum. 

 
5. Set one or more of the following to trigger data storage: 

    a) Time Change 
    b) RPM Change 
    c) Overall Change (the overall change in engineering units) 
 
For this example assume that  Time Change and RPM Change were both set to “None” and the 
Overall Change trigger for a channel was set to set to 0.25 mils.  
 

6. Click <OK>. 

With this configuration, data will be stored if . . .  the motor’s speed is greater than 200 RPM and less 
than 5000 RPM and the overall value changes by 0.25 mils [since the last trigger event].   In this case  
eZ-TOMAS will store time waveform and spectral gauge (band) data for all channels.  All event triggers 
are reset whenever any event trigger occurs. 

In other words: 

IF  minRPM < Motor Speed < maxRPM 

AND IF {delta Time, OR delta Speed, OR delta EU = specified setting} 

THEN data is stored. 
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Spectral Bands… (Ctrl+B)            Edit Menu 
 

Up to 14 Spectral Bands ( A through N) can be selected for each dynamic channel.  The first four bands 
(A, B, C, D) named Overall, DC Gap V,  1x Amplitude and 1x Phase are pre-defined and cannot be 
modified.  However, the user-defined bands (E through N) can be customized for specific applications. 

Spectral Band values are displayed on the dynamic instrument gauges.  All gauges are vertical, with 
exception of circular phase gauges.  When either 1x Amplitude, or 1x Phase is selected, both a vertical 
gauge [for 1x Amplitude] and circular phase gauge [for 1x Phase] are displayed.  

 

 
Spectral Bands Window 
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Input Channels Panel 

Selected channels have green backgrounds.  Non-selected channels appear with white backgrounds. 
Selected channels are listed by channel number and name.  The channel name is the one that is 
assigned in the Input Channels tab of the Edit menu’s Setup Configuration window, under the 
“Name” column. 

 
Spectral Bands Panel 

Band 
(A thru N) 

is the Spectral Band of interest.  Only the “User Defined” bands [E through N] can 
be modified. 

Spectral 
Band 

is the name you assign to a spectral band.  It is displayed on the dynamic instrument 
gauge in the main window.  A, B, C, and D are pre-defined. 

Freq Units can be either Frequency or Orders.  If you do not have a tach defined, the Orders 
option will not be available. 

Freq LO 
Freq HI 

Used to set the range of the frequency or order.  It is a good practice to set the range  
2 to 4 spectral lines wider than the frequency of interest.  This is due to the FFT 
window.  For example, if your frequency of interest is the 3rd order.  You should 
specify a range of 2.9 to 3.1 orders 

CALC Specifies to calculate Peak, Overall, Phase, or Unused.  
Peak is the highest spectral amplitude within the specified range.   
Overall is the sum of vibrations of each spectral amplitude, within the specified range. 
Phase is the time relationship between the vibration probe and tach signal. 
Unused

Amp LO 
Amp HI 

 does not calculate a value for the spectral band. 

Used to set the low and high amplitudes.  These high and low values define the gauge 
range. 

 
 

The lower potion of the Spectral Bands Window consists of a Spectral Band Toolkit panel.  The toolkit 
includes a field to enter machine speed in RPM, selection for 50 or 60 Hz line frequency, and selection 
for a band scale in Hz or Orders.  Aside from these, the toolkit includes 5 tabs: Bearing Faults, Motors, 
Gears, Pumps / Fans, and Belts. 

 
Spectral Band Toolkit Panel 

Nominal 
Machine Speed 
(RPM) 

Enter the machine’s nominal running speed. 

Line Frequency Select 60 Hz or 50 Hz, depending on the frequency of the power supply. 

Band Scale Choose Hz or Orders. 
 

Examples from the toolkit tabs follow. 
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Spectral Band Toolkit Tabs – Examples 

Bearing 
Faults 

 

Motors 

 

Gears 

 

Pumps 
Fans 

 

Belts 

 
Each of the tabs includes parameters related to a specific type of fault.  The tabs calculate and display frequencies 
 [or orders] which you can select with the left mouse button, then [with a click of the right mouse button] drag into 
the Spectral Bands panel.  In the following figure, 4 frequencies associated with bearing faults have been highlighted 
and dragged into position for spectral bands E, F, G, and H. 

 
Applying Bearing Fault Frequencies from the Toolkit to Bands E, F, G, and H 
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Spectral Limits… (Ctrl+L)            Edit Menu 
Overview 

The Limit Configuration window is accessed from the Edit pull-down menu by selecting “Spectral 
Limits.”  The window provides the user with a means of setting limits and ranges for multiple machine 
states for 1 or more Input Channels. 
 
A machine state can be defined by RPM and Delay Time (minutes).  For example, a machine state could 
be defined as 5001 to 10,000 RPM, but with a delay of 3minutes.  Thus the speed would need to be at least 
5001 RPM for 3 minutes. 
 
Six states are supported, where “0” is an RPM state not covered by the defined RPM ranges 1, 2, 3, 4, 5.  
See top central panel, following figure. 
 

 
 
There can be gaps between user-defined RPM ranges; however, the ranges may not overlap.   For 
example: Range 1 could be assigned to cover 400 to 800 RPM, and Range 2 could be set to cover 900 to 
1000 RPM, thus ignoring the 801 to 899 RPM range.   But you could not then reset Range 2 to cover 700 
to 1000 RPM because this new range 2 value overlaps those of Range 1.  When RPM ranges are used, 
there is a unique set of limit set-points for each combination of:  Input Channel, RPM Range, and  
Spectral Band.   For convenience, you may copy and paste limit settings between Channels. 

A different set of Limit Values for Spectral Bands A through J can be assigned to each of the six 
RPM ranges.  Click on one of the cells for an RPM range to see the limits assigned to that range.  The 
range currently selected is listed at the left side of the Limit Values panel.  In the above figure RPM Range 
2 (5001 to 10,000) RPM is selected. 
 
Up to four limits can be defined for each channel’s operating condition (LO-LO, LO, HI, HI-HI).  The 
alarm colors are defined in the Plot Display Preferences window.   If the channel value is lower than the 
LO-LO limit, the bar graph will change to the color indicated in the LO-LO column header (see following 
figure).  A value between LO-LO and LO limits will cause the bar graph color to change to the specified 
LO limit color.  HI and HI-HI limits have the same effect, relative to channel value.  A bar will be green 
for normal channel values (those between the LO and Hi limits). 

The window includes a Text Messaging feature that allows a message to be sent to up to 5 e-mail 
addresses.  Such messages are typically sent when triggered by an alarm condition.  The user can elect to 
include Spectral Band Data in the message by checking the associated checkbox.  
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Facts Regarding Spectral Limits 

 Limit values are not used if: 
(a)  the limit value is outside of the instrument range. 
(c)  the limit value is set to Zero. 

 Limits from one channel can be copied to another from the Limit Configuration Window’s Edit pull-down 
menu, using the “Copy Channel” option, or by selecting multiple channels. 

 
 Use the Input Channels Tab of the Configuration Window (selected from the Edit pull-down menu) to 

Select the Tach Reference on a per channel basis. 
 

 You can modify limits on the graphical bar graph display in the main window by dragging the limit 
arrows and then opening the Spectral Limits window to save your changes. Note that right-clicking on a 
gauge activates a pop-up [following figure] with several selection options, including “Edit Spectral 
Limits.”. 

 

 
Gauge Window Pop-up 
 

 
 The Alarm Log File panel [upper right of the Limit Configuration window] has a numeric field for 

entering “Records” is the number of Alarm events logged.  When an alarm occurs, eZ-TOMAS 
automatically saves the data to the History FIFO file. 

 
 The colors for the four limits (set in Edit Menu / Plot Display Preferences) are used in the Gauge 

Window, as illustrated in the following figure. 
 

 The Statistical Report can be used to generate limits for each machine state.  You can select channels, 
spectral bands, and variance for high and low limits.  A Limit Generation dialog box is accessed via the 
Statistical Report’s File pull-down menu. 
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Partial Spectral Limits Panel Showing 

 User-set Color Indications for LO-LO, LO, HI, and HI-HI 

 

 
Example of Limits Effects on the Gauge Colors 

 

 

 

 

Note: The Statistical Report can be used to generate limits for each machine state.  You can select 
channels, spectral bands, and variance for high and low limits.  The Limit Generation dialog box is 
accessed via the Statistical Report’s File pull-down menu.  See Chapter 8 for more information. 
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Digital I/O…                                                                                               Edit Menu 

Hardware Panel 

The top panel of the Digital I/O Configuration Window 
is the Hardware panel.   

 
Digital I/O Configuration 

For NDT Relay Modules

 For 

: 

(1) An NDTRelay must be connected as indicated in 
separate NDTRelay documentation. 

(2)  The applicable COM Port must be identified.  
Select the RS232 COM (serial) Port to which the 
output Relay module is connected 

640, 650, and 652 Analyzers

Relay Outputs Panel 

: 

For these 600 series analyzers, the Digital outputs are 
accessed via a 9-pin connector on the rear panel.  Refer to 
the associated product’s user manual for a pinout and 
additional details.  The manuals are located on the 
Dynamic Signal Analysis CD in Adobe PDF format. 

 

Relay outputs can be used to communicate Alarm Status to external devices.  Up to 8 relay outputs are supported. 
You must indicate, by checkmark, if a relay output is to be active.  For an “active” relay, the normal state is either 
Normally Open (NO) or Normally Closed (NC).  In the preceding figure, only Relay Output 0 is “Active.” 
 
When you click on one of the cells associated with a relay output, the “Alarm Events” that will trigger it appear to 
the right of the output’s switch graphic.  In the preceding figure we see the events that will trigger Relay Output 0.  
When any of the defined Alarm Events are True, the relay will be in the state other than indicated in the NO/NC 
column.  For example, in the following figure Output Relay 0 is normally closed; thus the relay will open when  
(a) Input Channel 1 is in Red Alarm Condition, or (b) Input Channel 3 is in Yellow Alarm Condition, or 
(c) Input Channel 5 is in Cyan Alarm Condition. 
 

 
Output Relay 0, Active, Normally Closed –  

Shown set to Open on Alarm Conditions on Channels 1, 3, or 5 

Digital Inputs Panel 

Digital Inputs can be used to trigger eZ-TOMAS Actions.  Each 
supported action is assigned to specific Digital Input.  For 
example, in the figure at the right, Store Snapshot is assigned to 
Digital Input 0.  This means that the Store Snapshot action will 
occur when Digital Input 0 changes state.  Note: Digital Inputs are 
available in NDTRelay2 [not NDTRelay1]. 

Store Snapshot Selected for Digital Input 0 
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Gauge Display Preferences… (Ctrl+G)                                                Edit Menu 
The Gauge Preferences window provides 
a means of independently setting the 
background colors of the control panel 
and primary gauge panel.  The Gauge 
Preferences window includes a font 
styles button which allows you to apply 
a global font change to the gauge and 
control panels.  The lower section of the 
Gauge Preferences window pertains to 
Gauge Properties.  In regard to the 
“Bands” column, to make a change you 
can drag a new Spectral Band type from 
the far right into the Band column.  You 
can also double-click in a cell and enter 
a desired Spectral Band letter (from A 
through N).  Channels can be edited in a  
similar manner. 

Note for 655 users: When a temperature channel is selected only two spectral bands will be listed at the right side of the 
window.  These are ‘A:Overall’ and ‘B:DCGapV.’ 

 

Plot Display Preferences… (Ctrl+D)             Edit Menu 
The Display Preferences Window provides a means of 
changing various display colors for the Plot Window.  It 
also allows you to change other display parameters, 
including, but not limited to, Waterfall latitude and 
longitude angles, and units for the frequency axis.  

Although most display preference functionality is self-
explanatory, the following information may be useful to 
some. 

The Plot Window panel allows you to define the Plot 
Display's border, background, grid colors, and the font 
style and size.  The panel includes an RT Buffer numeric 
field for indicating Realtime Trend.  This value defines 
the amount time [in minutes] that data will be displayed 
before scrolling will begin.  For example, if the Realtime 
Trend was set for 2 minutes the trend display would show 
the data being collected for two minutes, and then start 
scrolling after 2 minutes.  In this example the screen will 
always display the most recent 2 minutes of data.  

The Plot Trace Colors panel allows you to define colors 
for use in the plot displays.  If you select "By Trace" the 
sequential order of the Trace Number will define the plot 
color.  If you select "By Channel" colors will be assigned 
to specific channels according to the numbered color 
squares.  

The Alarms panel defines alarm colors.  The panel 
includes two numeric fields.  The upper field indicates the 
number of records to be displayed.  The lower field, for 
Pre/Post Alarm Event, defines the amount of data that  
will be displayed when using the Alarm Log report. 
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The Waterfall Display panel is limited to a fixed number of spectrum traces, 
up to 100 traces.  The Longitude Angle defines the vertical tilt of the display.  
The Latitude Angle defines the horizontal tilt. 

 

 

The Frequency Axis panel is used to set the frequency axis to Hz or CPM. 
Select Hz-Orders for cycles per second; or select CPM-Orders for cycles 
per minute. 

 

 

The Bode Display panel includes two checkboxes: Unwrap Phase and  
Flip RPM Axis. 

Unwrap Phase – when “checked,” the Y-axis scale can span multiple 360 
degrees.  Data will smoothly transition across the 0 / 360 boundary.  When 
“not-checked” the Y-axis scale is 0 to 360 degrees; and data that straddles the 
0 / 360 boundary will show a vertical line.   

Flip RPM Axis

 

 – is typically used for shutdowns (coastdowns).  When 
“checked,” the X-Axis (for RPM) reverses.  Thus an X-axis from 0 to 6000 
RPM would “flip” to show 6000 to 0 RPM.   

 

In addition to color changes, the Main Cursor and Harmonic Cursors can be 
shown with or without a vertical line.  Click on the first button [in the 
associated cursor panel to toggle to the desired choice (line or no line). 

 

 

The Orbit Display - Bearing Circle panel allows the user to select “Probe 
Location” or “X / Y Axis.”  The selection defines the Bearing Circle on the 
Orbit display.  If the bearing clearance is elliptical, select the locations that 
will be used to measure the clearance. 

 

 

When checked, the following information will appear in the header when you 
copy and paste a plot into a document or paint application: Company, Plant, 
Job No., Machine Name(s).  This information will be as entered in the Project 
Information window, which is accessed from the Edit menu. 
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Function Keys Preferences…            Edit Menu 
 

eZ-TOMAS can be controlled through a network via keyboard function keys (F1 through F12).   The Function 
Key Preferences feature allows you to define computer keyboard function key actions.   
 
Note: When you click on a Function Key row (such as F5 in the figure) a pull-down list appears – allowing for 
easy selection of a function. 
 
You can assign the keys to control starting and stopping acquisitions, limit checking, data storage, and to indicate 
what project is open.  Network Communication is via Port 7652.   
 
You can assign the “File – AutoBackup” menu option to a function key.  The AutoBackup feature allows you 
quickly backup the current eZ-TOMAS Project.  When this function is use a date and time string is added to the 
project name.   Note that the File Attributes of the backed up project are Read Only. 
The AutoBackup feature can be useful in Conjunction with the Network access of the function keys. 
 
You may contact IOtech for an example application.  
If doing so, please request:  EZT_netfkey. 
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Server Configuration… (Ctrl+R)            Edit Menu 
eZ-TOMAS can be configured to provide data and/or control to remote computers using a client/server architecture via 
TCP/IP.  The remote computers will need to have an authorized version of the eZ-TOMAS Remote application of the same 
version number as the eZ-TOMAS software being used. 
 
Refer to Chapter 10, Using eZ-TOMAS Remote, for details regarding server configuration.   
 
 
 
 

Copy Window…  (Ctrl+C)            Edit Menu 
“Copy Window” is not a window, but a command to copy the currently selected window to the clipboard.  
After using this command you can paste the copied window into another application, such as Microsoft 
Word or Excel.   The feature is useful for creating reports, or sending screen images to others via e-mail. 
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Control Menu 4 

 
The Control Menu allows you to enable and disable several functions which can also be controlled via switches and buttons 
on the lower panels of the Gauge Window. 

To minimize redundancy, information from Chapter 1 is not being repeated here with exception of the following figure.  
Please refer to Chapter 1 for details, if needed. 

 

 

Control Pull-Down Menu’s Relation to Lower Panels  

 

Note:  In regard to eZ-TOMAS Remote, the following four features can be used in either monitor or controller mode: Lock 
Limit Pointers, Show Gauge Setup, Show Gauge Values, Reset Peek Hold Values.  These four features are “machine 
local” only, meaning that their use [and the results of their use] never transfers from client to server or from server to 
client. 

These are the buttons from the “Options” panel 
[lower right section of the Gauge Window.  
This figure shows their corresponding menu 
selection. 
 
 
 
 
 
 
 
 
 
Double-click in this area to add notes.  Use the 
up/down buttons to scroll through the notes. 
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Display Menu . . . Plot Windows 5 

 
 

 Introduction …… 5-1 
Saving and Recalling Plot Setups …… 5-3 
Changing Display Ranges and Scales …… 5-4 
“Real Time” Plot Controls …… 5-5 
“History Data” Plot Controls …… 5-5 
Channels …… 5-7 

 

Introduction 
The Display pull-down menu [following figure] provides a means of displaying plot windows, logs, and 
reports.  This chapter covers the Plot Windows aspect.  Chapter 6 pertains to the various logs (reports) that 
can be generated from the menu. 

 
 

Select Plots from the Display Pull-down Menu 

 

Selecting Plot Windows from the Display pull-down menu opens a Data Display window (see following 
Window).  Note that you can double-click on a gauge to open a Data Display window for plotting that 
gauge’s data. 

For real-time displays, you can halt and resume the display of data by using the Pause/Continue toggle 
button, or use the “P” key on the keyboard. When viewing historical data, you can use the playback buttons 
and the slider to navigate through the data. 

You can view either real-time data or historical data.  In the examples that follow we are view historical 
data, thus the History button has been clicked, and appears “active” [green] on our screen. 

Prior to viewing a plot you need to: 

• select the channels to be displayed 
• select the desired data display format, e.g., Time Display, Spectrum, or Waterfall 
• select the data source, i.e., a “Real Time” source, or a history data file.   

 

 

Reference Notes: 
For toolbar button functions refer to Chapter 6. 
For examples of various plot display types refer to Chapter 7. 
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History Data – Orbit, Bode, Time Waveform, and Spectrum Displays 

Plot controls can be data that is in “Real Time” or pre-recorded, i.e., “History Data.”  A different set of 
control buttons will be present depending on which mode you are using.  In addition, Time Display and 
Spectrum Display formats differ in regard to certain control options. 
 
 

 

Reference Notes: 
For toolbar button functions refer to Chapter 6. 
For examples of various plot display types refer to Chapter 7. 
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Saving and Recalling Plot Setups 
You can save and recall plot setups.  If you typically need to display data in a fixed format, this option can 
simplify the display setup process.  After you can setup your plot displays, select the “Save Plot Setup” file 
menu option and save the setup.  The next time you need to display data in that format, you can use the  
”Recall Plot Setup” file menu option to quickly display data in that format. 
 

 
File Pull-down Menu 

for Plot Displays 
 
 

 
Preparing to Save a Plot Setup 

 
 

 
Preparing to Recall [Open] a Plot Setup 
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Changing Display Ranges and ScalesTo change the maximum or minimum range value (following figure):  Left-click on 
upper or lower scale value that is to be changed, then enter the new value.  An example follows.  This technique works for 
both X and Y axis. 

 
 

 

To change the X-Axis (following figures):  Hold down the <Ctrl> key, at the same time, left-click and drag the mouse 
cursor horizontally on the plot.  Two vertical cursor lines will define the new x-axis end points.  As an alternative, you can 
click the X-Scaling button and then drag the mouse cursor horizontally on the plot. 

  
 

To change the Y-Axis (following figures):  Hold down the <Alt> key, at the same time, left-click and drag the mouse 
cursor vertically on the plot. Two horizontal cursor lines will define the new Y-axis end-points.  As an alternative, you can 
click the Y-Scaling button and then drag the mouse cursor vertically on the plot. 

  
 

To simultaneously change the X & Y Axes (following figures):  Hold down the <Ctrl> and <Alt> keys, at the same time, 
left-click and drag the mouse cursor diagonally on the plot.  A rectangle will define the new area of the plot.  As an 
alternative, you can click the X-Y-Scaling button and then drag the mouse cursor diagonally on the plot. 

  
Note:  In regard to using toolbar buttons to change axis ranges, refer to Chapter 6. 

In this example, the cursor and PC 
keyboard were used to change the 
maximum scale value from 3.000 volts 
to 3.800 volts.  
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“Real Time” Plot Controls 
“Real Time” is the default data source.  For Real Time displays you can Halt and Resume the display of 
data by using the <Pause/Continue> toggle button (see following figure).  As an option to the <Pause/ 
Continue> button you can use the “P” key on the PC’s keyboard.  A table, which identifies all control 
buttons follows shortly. 

The <Clear Real Time Plot Buffer> button, which looks like a black “X,” allows you to clear the data in 
the realtime trend displays.  This display option can be used to clear the plot displays prior to starting a 
test.   
 

Selects 
Real Time 
Mode 

Pause/ 
Continue 

Clear Real Time 
Plot Buffer 

 
Real Time Mode is Selected 

 

 

“History Data” Plot Controls 
When viewing History Data (pre-recorded data files), you can use the set of playback buttons or the slider 
bar to navigate through the data.  A table, which identifies all control buttons, is presented in Chapter 6.  
Note that the playback buttons and slider remain hidden in the GUI when eZ-TOMAS is in the Real Time 
mode. 

History Data is accumulated according to the parameters setup in the Setup Configuration window’s 
Storage Tab, which is accessed via the Gauge Panel window’s Edit Menu. 

 

 
 

 Data Source- 
History File 

Play Back 
Buttons 

Record      Record / Total 
Pointer 

Playback 
Update Rate 

   
 

History Data (Playback) Mode is Selected 
 

The playback buttons from left to right are: Rewind, Step backward one record, Play Backward, Stop, Play, 
and Step forward one record 

Note that you can drag the History Data Slider (at the right of the play buttons) to a specific area of the file 
before you start playing back the data. 

  
The Playback Update [Delay] Slider allows you to slow down (delay) the playback update.  The delay value 
can be set to anywhere from 0 to 1000 milliseconds, in 200 millisecond increments. 
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Reference Note: 
Refer to Chapter 6 for more detailed information regarding Plot displays, 
associated toolbar buttons, and other controls. 

 

The default is the entire history file.  To change the start and end dates drag the green and red bands to the 
desired start and stop times, respectively.  As an alternative, you can enter the record numbers in the 
numeric fields for starting and ending records.  After defining the range, click <OK>.   

From the plot window, click the play button to play back the file.  

The History Data window includes a Show Alarm Log button.  Click the button to open a table of alarm 
events that are included in the file (if applicable).  You can select an alarm event to display the data that 
surrounds the event. 
 
The History Data window also includes a Show Snapshot Log button.  Click the button to open a list of 
data snapshots.  You can select a snapshot from the list to view it in the plot window. 
 

RPM Filter – This feature eliminates hysterisis and is therefore useful for trend displays, e.g., Stripchart, 
Polar, Shaft Centerline and Bode.  If the RPM Filter checkbox is checked eZ-TOMAS will only display 
data for increasing or decreasing RPM.  

 

 

Resize to the 
default range. 
 
 
Zoom in on the 
History range. 
 
 
Set range 
starting record. 
 
Set range 
ending record. 
 
 

Show 
Alarm Log 
 
 
 
Show Snapshot 
Log 
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 Channels  
 

 
A Time Waveform Display of 4 Channels 

*    Right-clicking on a channel button brings up a menu (see figure) which allows for changing some of the 
display characteristics for that channel, such as the color of the plot [channel trace]. 

 
** Right-clicking anywhere in the plot display area brings up a menu of many display options.  Refer to the 

menu at the left, in the above figure. 
 
 
 
The vertical channel bar at the right-hand edge of each plot represents the input channels.  The number of 
channels that can be displayed is dependent on the plot display format.  Some points regarding channels 
follow.  

• A color-filled channel box indicates that the channel is currently being displayed as a trace of 
matching color. 

• A white channel box indicates that the channel is active, but is not being displayed. 

• A dimmed channel number is not active, thus there is no data to display. 

• Multiple channels can be plotted on Time, Spectrum, Strip Chart, and Bode displays.  
Examples of plot types are provided in Chapter 7. 

• A single channel can be plotted on Waterfall, Polar, and Shaft Center Line displays. 

• For Orbit displays and for Shaft Centerline displays, the time display of a channel pair is 
displayed. 

 

 

Reference Notes: 
For toolbar button functions refer to Chapter 6. 
For examples of various plot display types refer to Chapter 7. 

* 
** 
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Toolbar Buttons 6 

 
1st Toolbar 

 
1 

 
Data Source-Real Time – selects the “Real Time” live data acquisition mode or the “History Data” (Play Back) mode.  

2 
 

Pause / Continue – toggles to pause or continue data monitoring.   Applies only to the Real Time mode. 

3 
 

Clear Real Time Plot Buffer allows you to clear the data in the realtime trend displays.  This display option can be used 
to clear the plot displays prior to starting a test.  

4 
 

Data Source-History File – Opens the History Data Dialog Box to select a file for viewing via the playback (history data) 
mode.  After clicking this button the playback buttons and related slider will appear. 

5 
 

Playback Buttons  – From left to right, the buttons are:  
Rewind, Step Backward One Record, Stop, Play, and Step Forward One Record. 

   

2nd Toolbar 

 
1 

 
Select Plot Setup File – Pops-up a list of saved plot setup files (.tps) which you can select to display. 

2 
 

Open New Plot Window – Adds one more plot window to the screen.  Note that there is a limit of 8 plot windows. 

3 
 

Align Plots, Vertical Orientation – Affective with 2 or more plots.  This function orients the plot windows such that they 
are longer in the vertical direction.  With 8 plot windows, eZ-TOMAS will display 2 rows of 4 plot windows. 

4 
 

Align Plots, Horizontal Orientation – Affective with 2 or more plots.  This function orients the plot windows such that 
they are longer in the horizontal direction.  With 8 plot windows, eZ-TOMAS will display 4 rows of 2 plot windows.  

5 
 

Time Waveform - Selects Plot Display window for which the x-axis is in units of time. 

6 
 

Spectrum –  Selects a Plot Display window for which the x-axis is in frequency-related units. 

7 
 

Orbit – Used to plot a time waveform for a channel pair.  The data will is displayed in a polar format. 

8 
 

Waterfall – Selects a Plot Display window that makes use of x, y, and z axis.  Waterfall plots display data as a series of 
Spectral Maps.  Some users refer to Waterfall Plots as Cascades. 

9 
 

Bode – Selects a plot display window in which the x-axis is scaled in RPM. 

10 
 

Polar – Selects a window for a circular plot.  Displays 1x Amp and Phase data in a polar format. 

11 
 

Stripchart – Selects a stripchart type plot display window. 

12 
 

Shaft Centerline – Used to plot a shaft centerline orbit as a trend in Gap Voltage for a channel pair.  The data is 
displayed in a polar format. 

13 
 

Spectral Bands – Bands A, B, C, and D are pre-defined as follows: A-Overall, B-DC 
Gap Voltage, C-1xAmp/Phase, D-1xPhase/Amp.  E through N are user-defined 

14 
 

Overlap Process -  Calculate and Save – Opens the Overlap Processing dialog box.  Overlap Processing can be used 
to analyze machine transients using continuous data in the FIFO history file.  This button is related to the Overlay Overlap 
Data button (15). 

15 
 

Overlay Overlap Data – Use this button to plot overlap processed data onto Bode or Polar displays.  The feature can be 
used to compare various startup and shutdown data.  This button is closely related to the <Overlap Process -  Calculate 
and Save> button (14). 

16 
 

Show Baseline – superimposes a pre-recorded baseline on top of display data. This option is only available in the Time 
or Spectrum plots.   Show Baseline is typically used to compare a spectrum with another (the baseline) which was taken 
when the machine was known to be in good working condition.  Show baseline is only available for multiple plot 
applications. 
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3rd Toolbar 

 
1 

 
Scale – Toggles between Instrument Scale, Auto Scale, and User Scale.   Instrument Scale is shown in the figure. 

 
 

Instrument 
Scale 

Instrument Scale is the default.  It displays the data based on the instrument’s Engineering Units range. 

 
 

Auto Scale 
Auto Scale automatically scales the axes based on the data being displayed. 

 
 

User Scale 

User Scale is used to display data in relation to a user-defined scale.  You can quickly customize a scale 
as follows: 

(1) press the <Ctrl> + <Alt> keys and hold them in. 
(2) press the <left mouse button> and hold in 
(3) move the mouse cursor to draw a rectangle around the area of the plot that you desire to view.  
(4) release the mouse button and the two keys.  Your plot should now have a new and more practical 
scale. 

2 
 

Manually Scale X and Y Axis – A diagonally oriented dual-arrow cursor appears.  The cursor lets the user 
simultaneously adjust both the X-axis and Y-axis by dragging the mouse.  

3 
 

Manually Scale Y Axis – A vertical dual-arrow cursor appears. The cursor lets the user manually adjust the Y-axis by 
dragging the mouse. 

4 
 

Manually Scale X Axis – A horizontal dual-arrow cursor appears.  The cursor lets the user manually adjust the X-axis by 
dragging the mouse.   

5 
 

Linear / Log Scale Y Axis – Spectrum Display Only.  This button allows you to switch between Linear and Log Y-axis 
scaling.  If you expand the data plot this feature is disabled until the plot is returned to its original scale via the Auto Scale 
button.  

6 
 

Frequency Axis – Used to set the x-axis to Hz, CPM, or Orders.   Applies to Spectrum Plot Windows only.   Each click of 
the Frequency Axis button toggles the x-axis unit of measure. 

  

 

 

7 
  

With 
Stripcharts 

selected 

Delta Time or Delta Record – For Stripcharts Only:  Selects one of two X-axis spacing types. 

(a)  When button (7) is gray, Delta Time is selected for the X-Axis.   Delta Time spacing displays data with 
absolute time for the X-axis. 

(b)  When button (7) is green, Delta Record is selected for the X-Axis.  Delta Record has X-axis time 
spacing based on record changes.  Thus the time line on the X-axis is not uniform.  Delta Record spacing 
is good when there are short acquisition durations over long periods of time as vacant time slots are 
eliminated from the display. 

  
 

With 
Waterfall 
selected 

Skip Records or Use All Records – For Waterfalls Only:  Selects one of two display modes.   

(a) When button (7) is gray, “use all Records” is selected and the entire Waterfall will scroll.  Scrolling can 
be forward or backward.    

(b)  When button (7) is green a maximum of 100 records will be scrolled based on a Skip Record Factor. 
SRF = History Records / Waterfall Records - 1.  Thus if we had 634 history records and 100 waterfall 
records we would have a skip factor of 6.4 records, i.e., 634 / 100-1 = 6.4 records.  This skip factor would 
result in 100 records being scrolled.  Note that the SRF is automatically calculated and applied by 
software. 

8 
 

Display Cursor Values  – allows you to show a plot cursor with annotation.  A cursor is provided with each plot trace.  
Cursors can be visible or hidden. 

9 
 

Show Frame Annotation – Shows a framed set of information such as machine names, user notes, and spectral bands. 

10 
 

Show RPM / Time Annotation - Active with Polar, Waterfall, and Shaft Centerline Plots.  Use this button to superimpose 
RPM or Time values onto the displayed data. 
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3rd Toolbar  (continued) 
 

 

11 

 

Harmonic Cursors – Can only be used when 1 trace is displayed.  Results in several cursors positioned to the right of 
the primary cursor and at intervals that are at twice the x-axis value of the primary cursor.  For example:  When the 
primary cursor is at 100 Hz, the first harmonic cursor will be at 200 Hz, the second at 400 Hz, the third at 600 Hz, etc.  
Moving the primary cursor to 400 Hz would result in the first harmonic cursor residing at 800 Hz, the second at 1200 
Hz, etc.   If Display Gauge Values is selected, the applicable values will be shown for all cursors.  Harmonic cursors 
can only be moved by moving the primary cursor. 

12 

 

Side Band Cursors – Can only be used when 1 trace is displayed.  Results in several cursors spaced at even 
intervals on both sides of the primary cursor.  Unlike the harmonic cursors, the sideband cursors can be moved by 
the user.  Once adjusted, they remain in position at until the next adjustment.  If Display Gauge Values is selected, 
the applicable values will be shown for all cursors. 

13 
 

Peak Cursors – Can only be used when 1 trace is displayed.  The cursors will automatically position at the highest 
peaks on the trace. 

14 
 

Multiple Trace Cursor 

Locked  - When locked, cursors for like plots are moved simultaneously.  As you move cursors in one spectrum, the 
cursors in the other spectrum plots move to the same X position. 
Unlocked - When unlocked, you can only move the cursors in the plot that has focus.  

15 
 

 

Cursor Update - Fixed X axis / Peak Search – When this button has a gray background, the x-axis is fixed and the 
cursor will not move when a new spectrum is plotted.  When the button has a green background “Peak Search” is in 
effect and the cursor will automatically move to the highest point on the plot.  The button is typically used for 
Spectrum plots, either Real Time or Historical Data.  

16 
 

Overlay Limits – For Spectrum, Stripchart, and Polar plot windows.   Superimposes the limit values onto the 
displayed data. 

17 
 

Runout Compensation – displays a graph of the RunOut compensated values for Bode and Polar plots. RunOut 
compensation is a vector math operation in which the referenced first-order amplitude and phase vector is subtracted 
from the displayed first order vector.  For Time Waveform and Orbit plots this shows time waveform compensation.  

18 
 

Overlay Bearing Clearance Circle – For Orbit and Shaft Centerline this button is used to superimpose the bearing 
clearance circle over the plot display. 

19 
 

Apply DC Coupling – For Bode, Stripchart, and Time Waveform this button is used to apply DC Coupling.  
Commonly used with Displacement Probes. 

 
 

 -/+ Spectrum Full – Sets the x-axis to have both negative and positive on the scale.  

20 
 

Double Differential – Changes the display by a double differential, for example, from Displacement to 
Accelerometer. 

21 
 

Single Differential – Changes the display by a single differential, for example, from Displacement to Velocity, or 
Velocity to Accelerometer. 

22 
 

Single Integration – Changes the display by a single integration, for example, from Velocity to Displacement, or 
from Accelerometer to Velocity. 

23 
 

Double Integration – Changes the display by a double integration, for example, from Accelerometer to 
Displacement. 

24 
 

Shaft Revolution Filter –  Used with Time and Orbit plots.  This filter selection is used to limit the amount of data 
displayed.  The limitation is set by selecting “n,” where “n” is equal to the number of shaft revolutions.  The Shaft 
Revolution Filter is used to make the plot display cleaner by reducing clutter from excess data.  Selection options are: 
N/A, 1 rev, 2 revs, 5 revs, and 10 revs. 

25 
 

Show User Notes –  Displays the User Notes from the Project Information window.  The notes are displayed in a 
free-moving, re-sizeable box.  You can enter text in this field.  
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Plot Examples                            7 

 
This chapter provides examples of the various plot types.  The following chapters are directly related to this 
one and may need reviewed or referred to. 

 

Chapter 5, Display Menu… Plot Windows, discusses: 
o how to save and recall plot setups 
o change display ranges 
o change scales 
o Real Time and History Data (playback) modes 
o channels 
o filtering data 

 

Chapter 6, Toolbar Buttons, identifies the layout of the 
toolbars and explains the purpose of each button. 

Selecting Plots from the Display pull-down menu opens a Data Display window.  Note that you can 
double-click on a gauge to open a Data Display window for plotting the data for that gauge. 

For real-time displays, you can halt and resume the display of data by using the Pause/Continue toggle 
button, or use the “P” key on the keyboard. When viewing historical data, you can use the playback buttons 
and the history data slider to navigate through the data. 

You can view either real-time data or historical data.  In the examples that follow we are viewing historical 
data, thus the History button has been clicked, and appears “active” [green] on our screen. 

Prior to viewing a plot you need to: 

• select the channels to be displayed 
• select the desired data display format, e.g., Time Display, Spectrum, or Waterfall 
• select the data source, i.e., a “Real Time” source, or a history data file   

 
The examples in this chapter consist of the following: 
 

 
Time Waveforms …… 7-1 

 
Spectrum …… 7-6 

 

Orbit …… 7-8 

 
Waterfall …… 7-12 

 
Bode …… 7-14 

 
Polar …… 7-16 

 
Strip Chart …… 7-19* 

 
Shaft Centerline …… 7-22 

 

 

 

 

 

*Note for IOtech 655 Users:   Use the Strip Chart for meaningful temperature plots.
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Time Waveform Displays 

Time Waveform displays show vibration amplitude as a function of time (seconds) for a block of time 
domain data.  This Block is the measured data used in Spectral Displays.  Note that multiple channels 
can be shown on the Time Display.  
 
Tach Pulse locations are shown with a black dot.  

 
Time Waveform, Fig. 1 - Unfiltered, Channel 1, Full Time Block, No Cursors 

 

 
Time Waveform, Fig. 2 - Unfiltered, Channels 1 and 2, 10 Revolutions, Cursor plus Sidebands 

 
DISPLAY CURSOR VALUES                       SIDE BAND CURSORS            10 REVOLUTIONS 

TIME WAVEFORM              SPECTRAL BAND A                                                SHAFT REVOLUTION FILTER 
                                         (OVERALL, UNFILTERED)                                        (FULL BLOCK IS THE DEFAULT) 

      TACH PULSE LOCATIONS  
(EACH BLACK DOT IS A LOCATION) 
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Time Waveform, Fig. 3 - Unfiltered, Channel 1, 10 Revolutions, Cursor, Single Differential 

 

 
Time Waveform, Fig. 4 - Unfiltered, Channels 1 and 2, Full Block, Cursor with Frame Annotation, DC Coupling 

DISPLAY CURSOR VALUES                                   SINGLE DIFFERENTIAL 

DISPLAY CURSOR              SHOW FRAME                      DC COUPLING 
       VALUES                         ANNOTATION                          
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Time Waveform, Fig.  5  - Filtered 1x, Channels 1 & 2, 5 Revolutions, Cursor 

 

 

  DISPLAY CURSOR                                                            SPECTRAL BAND C 
           VALUES                                                                       (1x Amp / Phase) 
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Time Waveform Compensation (selectable option) 
  

As an option, you can display compensated Time Waveforms.  Typically this compensation function is used to remove 
shaft runout from the data display.   

 
To use this feature: 

(a) view the history data  
(b) select the slow roll condition 
(c) select: File  
(d) select: Export 
(e) select: Runout 

 
You can now view data at steady state and select Runout Compensation. 
 
The following example, using channel 14, shows Uncompensated and Compensated plots. 

 

 

                  Time Waveform, Fig. 7 -  Uncompensated and Compensated (upper & lower respectively) 
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Spectrum Displays   

Spectrum Displays show vibration amplitude as a function of frequency.  The frequency units can be either Hertz 
(Hz), cycles per minute (CPM) or orders.   Multiple channels can be shown on the Spectrum Display. 

 

 

SPECTRUM              DISPLAY CURSOR  

  DISPLAY                          VALUES 

INSTRUMENT      DISPLAY       SHOW FRAME          HARMONIC CURSORS 
     SCALE              CURSOR       ANNOTATION  
                               VALUES 
 

                       LINEAR SCALE 

Spectrum, Fig.  1  

Channel 1, Instrument Scale, Cursor, and X-axis in Hz 
 

Spectrum, Fig.  2 

Chs 1 & 2, Linear Scale, Cursor + Harmonic with   
Frame Annotation, X-axis is in Orders 
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Spectrum, Fig. 3 -   Channel 1, Log Scale, Cursor plus Peaks with Frame Annotation, X-axis is in Hz 

 

 
Spectrum, Fig. 4 - Ch 1, Auto Scale, Cursor, X-axis is in Hz, Single Differential (Displacement to Velocity) 

INSTRUMENT        LOG SCALE         PEAK CURSORS 
     SCALE 
 

AUTO SCALE                             SINGLE DIFFERENTIAL 

                                                                                           (DISPLACEMENT TO VELOCITY) 
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Orbit Displays 

 

Orbit Displays show simultaneous time domain vibration amplitude for an X and Y probe pair.   

The location of each Tach pulse is shown on the orbit plot using black circles; and a rotation direction label 
("CCW" or "CW") is shown next to these (see figure).  

The default display is “Full Block” of time data.  However, a specific number of Shaft Revolutions can be 
displayed (1, 2, 5, or 10) by using the associated pull-down list (see figure).  The orbit display is corrected 
for probe location. 

You can optionally overlay the orbit onto a shaft center line display by clicking the Shaft Centerline 
button. The center of the orbit trace in SCL computes the difference between the current gap voltage and 
the reference gap voltage.  Information regarding shaft centerline plots is presented on page 7-20. 

To display an overlay of the bearing circle clearance, as indicated below (third plot), click the 
<Overlay Bearing Clearance Circle> button (see figure). 

Note:  Only one probe pair can be shown on the Orbit Display.  

    

 

Orbit, Fig. 1 - Channels 1 & 2* Unfiltered, Full Block, Instrument Scale 
 

*Channel 2 Pairing is from the Setup Configuration Window, Input Channels Tab, XY Pair Column 

INSTRUMENT         ORBIT               SPECTRAL BAND A                     FULL BLOCK 
       SCALE                                  (OVERALL, UNFILTERED) 
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Orbit, Fig. 2 - Channels 1 & 2* Unfiltered, 10 Revolutions, Autoscale 

 
*Channel 2 Pairing is from the Setup Configuration Window, Input Channels Tab, XY Pair Column 

  AUTO       ORBIT               SPECTRAL BAND A              10 REVOLUTIONS  

 SCALE                  
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Orbit, Fig. 3  - Chs 1 & 2* Unfiltered, 10 Revs, Autoscale, Overlay Bearing Clearance Circle 

 
*Channel 2 Pairing is from the Setup Configuration Window, Input Channels Tab, XY Pair Column 

   SPECTRAL BAND A                OVERLAY BEARING 
(OVERALL, UNFILTERED)          CLEARANCE CIRCLE 
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Orbit, Fig. 4  - Chs 1 & 2* Filtered 1x,  10 Revs, Autoscale, Overlay Bearing Clearance Circle 

 

*Channel 2 Pairing is from the Setup Configuration Window, Input Channels Tab, XY Pair Column 

SPECTRAL BAND C                    OVERLAY BEARING 
    (1x Amp / Phase)                      CLEARANCE CIRCLE 
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Waterfall Displays 

Waterfall Displays show a series of Spectrums on a 3D graph.  The X-axis is Frequency either Hz or CPM.  The Y Axis is 
Vibration Amplitude.  And the Z Axis is time.   Three examples follow. 
 
 
 

 
Waterfall, Fig. 1  - Channel 1, Scrolling Buffer, Cursor 

  
 
To adjust the Latitude Angle (Vertical Pitch) of the Waterfall display, Right Click in the Y-axis area and enter a value 
between 0 and +75 degrees.  This is indicated in the upper left corner of the display (see figure).  Unless you right-click 
in the Y-axis region, this feature will remain hidden. 
 
To adjust the Longitude Angle (Horizontal Pitch) of the Waterfall display, Right Click in the X-axis area and enter a value 
between -75 and +75 degrees.  This is indicated in the lower right corner of the display (see figure).  Unless you right-click 
in the X-axis region, this feature will remain hidden. 
 

 

*Note: 

 
 

 

Use All Records or Skip Records –  When Waterfall is selected this button determines which one of two display 
modes will be in effect.   

o Show Entire Range (Use All Records): When the button is gray, as indicated above, “Use all Records” is 
selected and the entire Waterfall will scroll.  Scrolling can be forward or backward. 

o Skip History Record:  When the button is green a maximum of 100 records will be scrolled based on a Skip 
Record Factor. SRF = History Records / Waterfall Records - 1.  Thus if we had 634 history records and 100 
waterfall records we would have a skip factor of 6.4 records, i.e., 634 / 100-1 = 6.4 records.  This skip factor would 
result in 100 records being scrolled.  Note that the SRF is automatically calculated and applied by software. 

Waterfall Figure 3 is an example of Skip History Record. 

WATERFALL           SCROLL THRU               DISPLAY CURSOR  

                                 ALL RECORDS*                      VALUES 
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Waterfall, Fig. 2  - Ch 1, Scrolling Buffer, Cursor, Overlay 1xA & 2xA & 3xA & 4xA, RPM Annotation 

 

 
Waterfall, Fig. 3  - Ch1, Skip Records Fill Buffer, Cursor, Overlay 1xA & 2xA & 3xA & 4xA, Time Annotation 

                       * In regard to “Skip Records,” see Waterfall Figure 1 and the associated note page 7-11. 

 USER                                                        RPM        
SCALE                                                 ANNOTATION                        SPECTRAL BANDS 

                                                                                                          (A, C, E, F, G ARE SELECTED) 

  SKIP RECORDS*                   TIME ANNOTATION 
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Bode Displays 

Bode Displays show vibration amplitude and phase as a function of rotating speed.  You can display the runout 
compensation values on the same plot by clicking the <Runout Compensation> button (see Bode, Figure 3). 
Runout Compensation is a vector math operation, in which the referenced first order amplitude and phase vector is 
subtracted from the displayed first order vector.   

 
Bode, Fig. 1   -   Channel 1, 1xA & 1xP, Cursor 

 
Bode, Fig. 2   -  Channel 1, Overall & 1xA & 1xP, Cursor 

 

BODE   
 
 
      DISPLAY CURSOR 

              VALUES 
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Bode, Fig. 3   -  Channel 6, 1xA & 1xP, Cursor 

You can view displays as either Compensated or Uncompensated.  When Runout Compensation is selected, a 
single “Compensated” trace is displayed.   

 

 
Bode, Fig. 4   - Channel 1, Overall, DC Coupling Applied, Cursor 

RUNOUT COMPENSATION 

DC COUPLING 
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Polar Displays 

Polar Displays show vibration amplitude and phase lag on a polar plot format. The data is corrected for probe 
location.  Phase lag is opposite the direction of rotation.  You can optionally display the “Runout” compensated 
values by clicking the associated button (see figure). The compensation values are specified for each channel in the 
setup configuration.  
 
Runout Compensation is a vector math operation, in which the referenced first order amplitude and phase vector is 
subtracted from the displayed first order vector. 
 
Note:  Only one channel can be shown on a Polar Display.     

 

 
Polar, Fig. 1 -  Channel 1, User Scaled 

USER SCALE                       POLAR DISPLAY 
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 Polar, Fig. 2 -   Channel 6, Runout Compensation 

 
You can view displays as either Compensated or Uncompensated.  When Runout Compensation  
is selected, a single “Compensated” trace is displayed.   

       RUNOUT 
COMPENSATION 
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 Polar, Fig. 3 -   Channel 1, Limit Region Overlay, RPM Annotation 

       RPM                                     OVERLAY 
ANNOTATION                               LIMITS 
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Strip Chart Displays 

Strip Chart Displays show selected instrument gauge values as a function of date and time.  Five examples follow. 
 

 
Strip Chart, Fig. 1 -   Channel 1, Overall, Cursor 

 

 
Strip Chart, Fig. 2 -   Channel 1, Overall & 1xA & 2xA, Cursor with Frame Annotation 

 

STRIP CHART 

FRAME ANNOTATION 
 



 

eZ-TOMAS & eZ-TOMAS Remote 887491 Display Menu … Plots           Plot Examples      7-20 
 

 
 Strip Chart, Fig. 3 -    Channel 1, Overall with DC Coupling Applied, Cursor 

 
Strip Chart, Fig. 4 -   Ch 1, Overall with DC Coupling Applied, Even Record Spacing on X-axis, Cursor 

 

*Note: Delta Time or Delta Record – When this button is used with Strip Charts, one of the two following modes will be effect.  
Each pertains to X-axis spacing. 

 (a)  When the button is gray (as in the upper plot display), Delta Time is selected for the 
X-Axis.   Delta Time spacing displays data with absolute time for the X-axis. 

 
(b)  When the button is green (as in the lower plot display), Delta Record is selected for the X-Axis.  Delta Record has X-
axis time spacing based on record changes.  Thus the time line on the X-axis is not uniform.  Delta Record spacing is good 
when there are short acquisition durations over long periods of time as vacant time slots are eliminated from the display. 

 
(c) A feature of the strip charts is that, DC coupling changes the strip chart format to represent +/- overall value.  The width 
of the bars represents the density of measurements.  Note the difference in figures 3 and 4. 

 

DC COUPLING 
 

EVEN RECORD SPACING                     DC COUPLING 

            ON X-AXIS* 
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 Strip Chart, Fig. 5 -   Channel 1, Overall, Limit Values Overlayed, Cursor 

OVERLAY LIMITS 
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Shaft Center Line (SCL) 

Shaft Centerline (SCL) is used to display the change in gap voltage for a Channel Pair.  SCL is typically 
used in conjunction with Displacement Probes.   

 

 
 
 

In order to get valid SCL displays the input channels must be DC coupled.  
 

 

The measured DC Gap Voltage is corrected to the Gap Reference Value and Shaft Starting Location  
(Brg Start), which are set in the Edit pull-down menu’s Setup Configuration window, in the Input 
Channels tab. 

 

       
Shaft Centerline, Fig. 1  

 

                    DISPLAY                                            SHAFT                                                        OVERLAY BEARING 
                   CURSOR VALUES                        CENTERLINE                                                  CLEARANCE CIRCLE 
 
 
 
 
 
 
 
 
 
 
 
                                                                                  ECCENTRICITY (e) 
 

Note:    Eccentricity “(e)” is computed and displayed as a cursor value for Shaft Centerline plots.   
 Eccentricity is the ratio of current gap to the bearing clearance. 
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 Shaft Centerline, Fig. 2  -   Ch 3 & 4*, Bearing Clearance Circle, RPM Annotation 

 
*Channel 4 Pairing is from the Setup Configuration Window, Input Channels Tab, XY Pair Column 

  OVERLAY BEARING 

 CLEARANCE CIRCLE 
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Display Menu . . .   Reports and Logs 8 

 

Statistical …… 8-1 

Alarm Log …… 8-4 

Snapshot Log …… 8-6 

Production Test Report …… 8-7 

Configuration Setup [.txt File] …… 8-8 
 

 

Display Pull-down Menu 

 

eZ-TOMAS can generate the following types of logs and reports: Statistical, Alarm, Snapshot, Production 

Test, and Configuration Setup text file (.txt).   Note that Plot Windows, which can also be selected from the 

Display pull-down menu, are discussed in Chapters 5, 6, and 7. 

Statistical Report 

The Statistical Report lists the historical spectral band data.  It includes the instrument, the engineering 

units, the minimum value, the mean average value, the maximum value, and the standard deviation by 

channel.   

The Statistical Report can be accessed from the Gauge Window’s Reports Pull-down menu. 

 

 
Statistical Report 

 

The report can be saved as an ASCII text file for further use. 

This data can be used to generate or fine tune limits.  Note that you can have eZ-TOMAS automatically 

compute limit values by selecting Generate Limits on the File menu.  You can view and modify limits by 

selecting Limits in the Gauge Window’s Edit pull-down menu.  Chapter 2 contains additional information. 
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Accessing a Statistical Report 

To obtain a Statistical Report you need to specify the time period that the report is to cover.  This is 

accomplished as follows: 

1. From the Gauge Window’s Display pull-down menu, select Statistical.  The Select History Data 

window will open (see following figure). 

 

 

Select History Data Window 

2. Select the start and end points to define the period the report is to cover.  You can do this by entering 

record numbers in the numeric fields at the left, or by dragging the green and red bands.  Page 2-4 of 

this manual contains detailed instructions.    

3. Click the <OK> button to display the report. 

4. To save the Statistical Report as an ASCII text file, select Save the Report from the Statistical 

Report’s File pull-down menu (see following figure). 

 

 
 

The Statistical Report’s File Pull-down Menu 

With options to “Save the Report” and to “Generate Limits” 

 

Statistical reports can be used to automatically generate limit values based on historical data.  If your 

monitored machine has been operating at a steady state condition and if you have stored data at this 

condition, then eZ-TOMAS can use this data to determine limit values based on the average and variance 

of the data.  However, you probably will want to edit these limits if the machine is experiencing amplitude 

or frequency shifts. 
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Using a Statistical Report to Generate Limits 

Statistical reports can be used to automatically generate limit values based on history data. If you have 

acquired and stored data at a steady state machine condition Tomas can calculate limits for you based on 

the Average and Variance of the data. 

1. On the Display pull-down menu select Statistical; the History Data window will open. 

2. Drag the top slide pointer across the time scale to select the Start Date and Time for the report. 

3. Drag the lower slide pointer across the time scale to select the End Date and Time for the report. 

4. Click the <OK> button.  The Statistical Report will be displayed. 

5. Open the File menu (in the Statistical Reports window). 

6. Select “Generate Limits.”  The Limit Generation dialog box will appear (see following figure). 

7. Use the checkboxes, as applicable, to select: (a) the Input Channels for which you want Limit 

Calculations performed,  (b) the Spectral Bands for which limits should be generated, (c) the 

RPM Ranges, if applicable, (d) the Standard Deviation to be used for HI HI (Danger), HI 

(Alert), LO (Alert), and LO LO (Danger).  (See following figure). 

 

 

Limit values are not used if: 

(a)  the „HiHi limit value‟ minus the „LoLo limit value‟ is less than 5% of the 

instrument scale, or 

(b)  the limit value is outside of the instrument range. 

 
 

                  Limit Generation 

8. Click the <OK> button.  A prompt will appear, asking if you want to Save New Limits. 

 

9. Click <Yes>. 
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Alarm Log 

eZ-TOMAS triggers data storage based on Alarm Events.  Whenever an alarm occurs, the program 

automatically stores the following Time Blocks for all Input Channels: 

o One Time Block prior to the Alarm Event 

o The Time Block which the Alarm Event occurred in 

o “N” Time Blocks after the Alarm Event 

From the Alarm Log you can select an event of interest, then click the <Display> button to display data 

from the event, the preceding time block, and a specified number of blocks following the event. 

The Alarm Log (following figure) includes the date and time, the channel number, reference tachometer, 

instrument name, spectral band type, alarm type, and value of the alarm signal.  

You can access the Alarm Log from the Gauge Window’s Display pull-down menu, or by clicking the 

<Show Alarm Log> button [located in the History Data File window]. 

 

 

             Two Ways to Access the Show Alarm Log 

 
Alarm Log 

The Alarm Log contains the last “N” number of alarm events, where 

“N” is the number of Records specified in the Limit Configuration 

window.  In the following figure the number of records has been 

set to “100.” 

 

Show 

Alarm 

Alarm Log File Records 

 in the Limit Configuration Window 
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In the visible portion of the following Alarm Log we see that the LoLo alarm state occurred 7 times,  

the Lo alarm state 2 times, and the HI HI alarm state 5 times. 

 

Alarm Log 

 

Note:   From the Alarm Log you can select an alarm event then click the <Display> button to display data 

from that alarm event.   You can also display the data by double-clicking on the desired alarm event 

 

To save the Alarm Log select “Save the Report” from the window’s File Menu.  The log is saved as a  

TXT file associated with the TOMAS project.  Notepad is automatically activated to show the Alarm log.   
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Snapshot Log 

 

 

  

 

 

 

 

 

 

 

 

 

                         Snapshot Log Button 

                

The Snapshot Log can be accessed from the Gauge Window’s Display pull-down menu, or from the 

History Data Window.   

The Snapshot Log file contains entries which were created whenever the user clicked the <Snapshot> 

button, which is located in the Gauge Window’s Data Storage panel (see following figure).  That button 

should not be confused with the <Show Snapshot Log> button, which is located in the History Data 

Window. 

The <Snapshot> button captures “N” seconds of continuous data which is stored in the log.  In the above 

figure the log contains 2 entries. 

 

 

 

 

 

 

 

<Snapshot Button>  

on the Gauge Window 
 

This similar button [on the gauge window] can 
also be used to take a snapshot of data. 

 

Do not confuse this button with the Snapshot Log Button. 

Two Ways to Access 

 the Snapshot Log 
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Production Test Report . . . 

You can use eZ-TOMAS to create a Production Test Report.  When the feature is selected from the 

Display pull-down menu, a screen similar to the following will appear.   

 

 

Configuring a Production Report 

 

Reports are created using your custom settings.   Among the options available you have your choice of: 

 

 Input Channels 

 RPM Ranges 

 Spectral Bands 

 Start and End Dates in the History File 

 Format Options: including Portrait or Landscape, Displaying Minimum and/or Maximum values, 

display Pass and Fail labels (for example, you could have “Schedule Maintenance” as a label. 

 Machine Test Information (from the Project Information dialog box) 
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Example of a Production Test Report 

Configuration Setup   [.txt File] 

Selecting “Configuration Setup” from the Reports pull-down menu creates a text file that contains configuration 

details of the current project.  The printed text file provides a backup of the project's configuration. 

 

 

The Beginning of a Setup Configuration .txt File 

 

Sections of a Report 
 
Program and Version 
Project Path 
Report Date/Time 
 
PROJECT Information 
ACQUISTION Setup 
DATA STORAGE Setup 
INPUT CHANNELS Setup 
SPECTRAL BAND Setup 
SPECTRAL LIMITS Setup 
DIGITAL IO Setup 
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Security Menu   [In Gauge Window] 9 

 

 

 

 

 

 

Security Pull-Down Menu 

 

eZ-TOMAS has three Security Levels.  Note that these levels have no impact on eZ-TOMAS Remote. 

 User Level 1 - allows users to View Gauge data in the Main menu and Print. 

 User Level 2  - Level 2 operators cannot start or initialize a project, erase the History file, edit the 

configuration, or change the security password.. 

 User Level 3 - has full privileges, which include the ability to start new projects and erase History 

files.  Level 3 is password protected. 

 

After selecting User Level 3, a dialogue box similar to the following will appear.  The user must enter the 

project’s Level 3 password to enable full privileges. 

 

 

 

 

 

 

 

 

 

 

 

No password is required to go from Level 3 down to Level 2 or to Level 1.  However, the project password 

is required to move from Level 1, or Level 2, to a higher level.

Security Level 3 Dialog Box 
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The “Change Password” command, in the Security pull-down menu, opens the Change Project Password 

dialog box (see following figure).  This dialog box will only be visible when the user selects the “Change 

Password.” option.  Note that you can only access the Change Project Password box from User Level 3.  

 

 

 

 

 

 

 

 

 

 

 

 

To change the password: 

1. Open the Security pull-down menu. 

2. Select “Change Password.”  Note that you can only do this from User Level 3. 

The Change Project Password dialog box will open. 

3. Type the desired password in the field below “Enter Level 3 Password.” 

4. Re-enter the password in the “confirm” text box. 

5. Press the <OK> button.   

 

If the confirmed password was entered correctly the new password will be in effect. 

 

 

Changing the Project Password 
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What is eZ-TOMAS Remote?……  10-1 

Installing eZ-TOMAS Remote …… 10-2  

Running eZ-TOMAS Remote…… 10-3 

eZ-TOMAS Remote Operations…. 10-4 
Monitor Mode ….     10-4 

Controller Mode …. 10-5 

Configuration …. 10-6 
      Server Configuration - Settings needed in eZ-TOMAS ….. 10-6 

       Client Configuration - Settings needed in eZ-TOMAS Remote …..  10-8 

How to Read Status Lines…… 10-11 

An Explanation of Offline Status …… 10-12 

Working with Previously Recorded Projects ……10-13 

Troubleshooting……  10-13  

 

 

What is eZ-TOMAS Remote? 

eZ-TOMAS Remote is a software application that allows you to remotely monitor and/or control eZ-

TOMAS applications through client/server architecture.  The server, an eZ-TOMAS application, interacts 

with the hardware; and can be in a remote location.  Each client (eZ-TOMAS Remote) communicates with 

eZ-TOMAS via TCP/IP.   

 

 

Two eZ-TOMAS Remotes Communicating with one Server (eZ-TOMAS) 
eZ-TOMAS Remote can be used to monitor and/or control multiple eZ-TOMAS applications. 

 

 

Several clients can run simultaneously to monitor an eZ-TOMAS application.  In addition to monitoring 

and controlling eZ-TOMAS applications, you can create unique plot setups that are local to eZ-TOMAS 

Remote.  In other words, you can create custom display setups that exist only at the client. 
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As indicated in the following figure: 

 Each eZ-TOMAS application can be monitored by multiple clients. 

 Each client can monitor multiple eZ-TOMAS applications. 

 

 

 
 

 

 

 

Two eZ-TOMAS Remote Clients Monitoring Three eZ-TOMAS Servers 

 

 

Installing eZ-TOMAS Remote 

eZ-TOMAS Remote installations are entirely independent of eZ-TOMAS installations.  However, the software 

version number of eZ-TOMAS Remote must match the version number of eZ-TOMAS (on the server PCs) for 

proper operation. 

System Requirements 

 10/100BaseT Ethernet port  
       [on PC or on a hub connected to the Ethernet] 

 Monitor: SVGA, 1024 x 768 screen resolution 

 Windows 2000 SP4 and Windows XP users: 
       PC with Intel™ Pentium 
       1 GHz or equivalent; 
       512 MB memory 
       10 GB disk space 

 Windows Vista users: 
      PC must be Windows Vista Premium Ready 

 

In addition to meeting the system requirements above, verify that you have the following: 

 Dynamic Signal Analysis (DSA) CD 

 License Key for eZ-TOMAS Remote 

 User documentation: available in pdf format on CD and on-line at: www.iotech.com/manuals.html 

 

 

eZ-TOMAS Remote 
Applications (Clients) 

eZ-TOMAS Applications (Servers) 
 connected to Dynamic Signal Analysis Hardware 

http://www.iotech.com/manuals.html
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eZ-TOMAS Remote and eZ-TOMAS version numbers must match in order for 

 eZ-TOMAS Remote to operate.  

  

 

An effective firewall will likely alert the eZ-TOMAS host application when eZ-TOMAS 

Remote is trying to monitor information or take control; and will block such remote 

attempts.  We recommend that you maintain firewall protection; however, you will need to 

set your firewall to allow access to eZ-TOMAS Remote.  As used here, providing firewall 

access means making ports used by clients and servers open [on both ends]. 

 

Software Installation 

1. Start Windows. 

2. Close all running applications. 

3. Insert the Dynamic Signal Analysis CD into your CD-ROM drive and 

 wait for the CD to auto-run. 

If the CD does not start on its own: 

(a) click the desktop‟s <Start> button 

(b) choose the Run command 

(c) select the CD-ROM drive, then select the setup.exe file. 

(d) click <OK>. 

An Opening Screen will appear. 

4. Click the <ENTER SETUP> button. 

5. From the hardware selection screen [which follows a licensing agreement], select the type of data 

acquisition device you are using from the drop-down list. 

6. Continue to follow the on-screen instructions. 

 

 

Reference Notes: 

Adobe Acrobat PDF versions of documents pertaining to hardware and software are 

automatically installed onto your PC‟s hard-drive as a part of product support at the time 

of software installation.  The default location is the Programs group, which can be 

accessed via the Windows Desktop Start Menu. 

 

 

Running eZ-TOMAS Remote  

To run eZ-TOMAS Remote, double-click the associated icon or use your Windows desktop Start button to 

navigate to the program.  This is located in the programs group by default. 

The first time you start the application you will be prompted for your name, your company name, and a 

license number.  The number will activate eZ-TOMAS Remote for every day operations.  Note that the eZ-

TOMAS code does not apply to eZ-TOMAS Remote, and will not activate it. You must use the license key 

specified for eZ-TOMAS Remote. 

If you are loading your software from a CD, the license key will be available on an Authorization Code 

Sheet that accompanied the CD as part of your order.  If you downloaded your software from the website, 

your license key (authorization code) will be e-mailed to you within one business day. 

The program‟s main window appears after your license key is accepted. 
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eZ-TOMAS Remote Operations 

A single eZ-TOMAS Remote client can control multiple eZ-TOMAS servers.  As indicated in the figure on 

page 10-1, when connected to a server, eZ-TOMAS Remote has two modes of operation: 

 Monitor mode 

 Controller mode
1
 

 
1
 The words controller and control in this context and that which follows pertains to control of the state and configuration of  

eZ-TOMAS, not to the control of the item being monitored.   
 

 

Monitor Mode 

Monitor mode allows you to view data from an eZ-TOMAS application.  You can view gauges and plots; 

and the data viewed can be live or historical. 

 

 

eZ-TOMAS Remote – Monitor Mode, Gauge Window 
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Controller Mode 

The controller mode allows you to control every aspect of the acquisition state for an eZ-TOMAS 

application.  While in the controller mode you can:   

 Configure an acquisition 

 Set Limits 

 Configure Digital I/O 

 Start and stop acquisitions 

 View gauges and plots 

 

 

 

eZ-TOMAS Remote – Controller Mode, Gauge Window 

 

 

 

A client may be enabled as a controller for a server if eZ-TOMAS is configured to permit such control, as 

discussed in the next section.   

 

 

For each eZ-TOMAS application (server) there can only be one remote client configured 

in the controller mode.   
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Configuration 

Server Configuration - Settings needed in eZ-TOMAS 

 

 

Before connecting a client (eZ-TOMAS Remote) to the server, the following must be performed 

via eZ-TOMAS: 

(a) initialize the project 

(b) verify hardware communication 

(c) configure the acquisition 

(d) set the input channels, and  

(e) configure the server 

 

   

To configure the server: 

 
 

 

1 Open the eZ-TOMAS gauge window [main 

window]. 

2 Open the Edit pull-down menu  

(figure at right). 

3 Select Server Configuration, as indicated in the 

figure.  As an alternative you can use the shortcut, 

Ctrl+R. 

A Server Configuration dialog box will appear (following figure).   

  

Selecting “Server Configuration” from 

the eZ-TOMAS Edit Menu 
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Server Configuration (In eZ-TOMAS) 

It is important to properly configure the server to meet your application‟s needs.  Forgetting to enable the 

data server, for example, would result in no clients having access to the server.  The following table 

describes the server configuration options and is broken down by panel.  

 

Server Configuration Dialog                                         Resides in eZ-TOMAS,  access via Edit pull-down menu 

eZ-TOMAS Server Panel 

Enable Data Server Enables the data server when checked.  Clients cannot connect to eZ-TOMAS when the data 
server is not enabled.  The default value is “unchecked” (server not enabled). 

TCP/IP (Winsock) 
Port 

The port number is used to establish communication between the client and the server. The 
server establishes and displays a range of port numbers that it listens to.  Note that each 
remote that connects to a server must use a different port number for that server. 

Enable Controller 
Access 

Allows an eZ-TOMAS Remote client to get control access (controller mode). Note that for 
each eZ-TOMAS application, at any given time, there can only be one client in the controller 
mode.   If this box is not checked clients are limited to the monitor mode, assuming that the 
data server is enabled. 

Network Update Panel 

Update Rate 
(seconds) 

Specifies how often the data sent over the server will be updated.  The value must be at 
least 1 second, and no more than 60 seconds. 

Controller Authorization Panel 

Controller 

Password
1
 

Sets the password that is required in order for a client to access controller mode.  The 
password alone is not sufficient to access controller mode.  In addition, the data server and 
controller access must both be enabled. 

Inactivity Timer 
(minutes) 

Allows you to set an inactivity time for a logged-in controller.  If no activity occurs within 
the set period of time, another client can take control without receiving a prompt. 

Activity in this case, is defined as making configuration changes. 

Enable TCP/IP 
Validation 

This feature allows the host eZ-TOMAS to grant controller mode access to one specific 
client, as determined by its TCP/IP address. 

TCP/IP Address When the Enable TCP/IP Validation checkbox is checked, the TCP/IP address in this field 
determines which client (only one) is permitted to have controller mode access.   

 
1 

The Monitor and Controller Modes of eZ-TOMAS Remote are entirely independent of User Level Security settings set in 

eZ-TOMAS.  The eZ-TOMAS Remote controller password has no relation to the eZ-TOMAS security level password discussed 
in Chapter 9. 

 

 

To avoid conflict between eZ-TOMAS and a client controller, uncheck the Enable 

Controller Access check box Prior to making any configuration changes via the Edit 

menu in eZ-TOMAS.  In addition, avoid making any controller authorization changes 

while one or more remote logins are active.  
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Client Configuration - Settings needed in eZ-TOMAS Remote 

 
A Servers Panel resides on the left side of the eZ-TOMAS Remote gauge window.  

  

 
eZ-TOMAS Remote, Servers Panel 

 

 
You can configure the Servers panel to have hosts via the Servers Connections dialog box.   

 

To access the Servers Connections dialog box you can use the <Server Configuration> button that resides 

in the Servers panel [see preceding table]; or you 

can: 

 

1. Display the eZ-TOMAS Remote main 

(gauge) window. 

2. Open the Edit pull-down menu.   

3. Select Server Connections (see 

following figure). 

As an alternative to these steps you can 

use the shortcut, Ctrl+R. 

 

 
 

After selecting Server Connections, its dialog box 

appears (following figure).  The dialog allows you 

to enable servers, which can be specified by IP 

Address or hostname.   You can specify an update 

 rate for each server.   

 

  

Servers Control Item Function 

    

Server 
Configuration 

Clicking this icon brings up the Server Configuration dialog box. 

     

Server 
Refresh 

Clicking this icon forces a refresh of the server status. This is used for first time connection of a server 
and for servers that go offline, for example, if port timeout was exceeded during communication.    

Note that increasing the Port Timeout increases the time it takes for refreshing the server list [when 
servers are truly not on line].  For example, if a server is 1) really offline, 2) is in the refresh list, and 
3)Port Timeout is set to 30 seconds; then every time you click the <Refresh> button  the operation will 
take 30 seconds to time out [before completing the refresh operation. If you know the server is really 
offline, you can disable it to avoid the unwarranted slow refresh.   

           Server 
Update 

Checking the Server Update box enables automatic updates of server status.  The update rate is 
defined on a per server basis in the Server Connections dialog box. 

    No Servers                                                                                 Two Servers (One Offline) 

Selecting “Server Connections” from the 

eZ-TOMAS Remote Edit Menu 
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If multiple clients will access a single server, each client requires a unique TCP/IP Port number.  This means that 

coordinating the access of multiple clients to a single server must be done by port assignment.  Ports are provided on a first 

come first serve basis.   

 

If two clients happen to specify the same port, then the second client will get an offline indication from the server.  There is 

no indication as to whether the offline condition is caused by an inactive or non-existent server, or by a server whose port 

is already in use.  Up to 32 ports can be used.  

 

 

Be aware that an effective firewall will likely alert the eZ-TOMAS host application when  

eZ-TOMAS Remote is trying to monitor information or take control; and will block such remote 

attempts.  We recommend that you maintain firewall protection; however, you will need to set your 

firewall to allow access to eZ-TOMAS Remote.  As used here, providing firewall access means making 

ports used by clients and servers open [on both ends].  

 

 
The Servers Connections Dialog Box   

 
Servers Connections Dialog Box, Column and Field Descriptions 
Resides in eZ-TOMAS Remote, access via Edit pull-down menu 

No. A pre-set value from 1 to 32.  The column provides a numerical list of the host machine and servers. 

Enabled A checkbox is used to enable (checked) or disable (unchecked) a server.  If already connected, 
unchecking the box doesnot remove the client from the Remote Network Connections dialog in the  
eZ-TOMAS server until after the client is restarted.   Unchecking the box does remove the eZ-TOMAS 
server from the eZ-TOMAS Remote servers tree and from the refresh list. 

Name/ 
IP Address 

Identifies the local host (eZ-TOMAS Remote host PC; which is always item number 1) and server IP 
addresses. 

Alias An opptional user-friendly name for the server.  For item 1, the local host, the alias of “My 
Computer” is used and cannot be changed. 

TCP/IP Identifies the port that is being used for a servers’s Transmission Control Protocol (TCP) and the 
Internet Protocol (IP).  Each server must use a unique port.  Note that the local machine, not being a 
server, has no TCP/IP port assigned. 

Update Rate The amount of time (in seconds) that will elapse before the status is updated. 

Port Timeout 
(seconds) 

The amount of time that must elapse before a port is is designated as “Offline” in eZ-TOMAS Remote.  
The timeout value must be no less than 1 second and no more than 60 seconds.  For more 
information pertaining to Port Timeout and its relationship with Offline status, refer to the section, 
An Explanation of Offline Status. 
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Each configured server is listed on eZ-TOMAS Remote‟s Server Panel [on the left side of the Gauge Window].   

Each server name is followed by a status line.  The following figure provides two examples of status lines. How to 

read staus lines is discussed in the subsequent section.  

 

 

 
An Example of the “Servers Panel” in eZ-TOMAS Remote with 2 Servers Enabled 

 
 

 

Clicking on a server in the server panel (previous figure) brings up a password prompt. This prompt allows you to 

request controller mode by checking „Login as Controller‟ or for the monitor mode, by leaving the the checkbox 

unchecked.  

 

 

 

 

 

 

 

 

 

To complete the request for controller mode you must enter the correct eZ-TOMAS „controller password,‟ which 

was specified on the server (eZ-TOMAS application).   

 

No pasword is required for monitor mode. 

 

 

 

  

Status 
Lines 

Server 
Panel 
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How to Read Status Lines 

Each status line shows the overall status of a server (an eZ-TOMAS application).  Note that these lines are updated 

regardless of whether or not the remote is logged onto the server.   

 
Designator 
Position 

Designator Indication for the associated server 

First A “A” indicates that a live acquisition is currently in progress. 
 

 - “-“ indicates that no live acquisition is in progress 
 

 Offline The term “Offline” refers to both (1) the associated server, and (2) the server connection.  
When a server shows a status of Offline the server may, in fact, be available; but a network 
connection [to the server] may not be.   “Offline” will be the sole entry in the status line, 
when the Port Timeout value is met.  The port timeout value is set [in seconds] in  
eZ-TOMAS Remote’s Servers Connections dialog box.  For more information refer to the 
section, An Explanation of Offline Status, which immediately follows this table. 
 

Second L “L” indicates that limit checking is enabled. 
 

 - “-“ indicates limit checking is not enabled. 
 

Third D “D” indicates the Digital I/O state is enabled. 
 

 - “-“ indicates the Digital I/O state is not enabled. 
 

Fourth* OK “OK” indicates no alarm limits have been reached. 
 

LOLO “LOLO” indicates that a channel value dropped below the LO-LO limit value. 
 

LO “LO” indicates that a channel value dropped below the LO limit value, but not below the LO-
LO limit value. 
 

HI “HI” indicates that a channel value rose above the HI limit value, but did not exceed the HI-
HI value. 
 

HIHI “HI-HI” indicates that a channel value rose above the HI-HI limit value. 
 

Fifth ___ RPM If a tachometer is specified “on” for the configuration, then the RPM is shown as long as the 
RPM value is other than zero.   

 
*  The fourth status designator consists of 2 or 4 letters; and indicates the operational status in relation to alarm limits.  

The status is associated with the highest severity [of any limit and channel].  The limit values are set in the Edit menu. 

  

Status 
Lines 

Server 
Panel 
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An Explanation of Offline Status 

 
The term “Offline” refers to both (1) the associated server, and (2) the server connection.  When a server 

shows a status of Offline the server may, in fact, be available while the network connection [to the server] 

may not be.  

 

 eZ-TOMAS Remote uses a polling technique to obtain status and data.  Each network request is protected by 

a port timeout, for which the value is set in the Server Connections dialog box [in eZ-TOMAS Remote].  If a 

request is not answered within the specified timeout interval, the connection will show a status of Offline.   

 

 

An excessive occurrence of Offline states, while a server is known to be available,  

is a strong indication that the Port Timeout should be set to a higher value.   

 

 

Setting a higher Port Timeout value will typically reduce the number of Offline occurrences.   The following 

factors should be considered when resetting the Port Timeout.  

 

Server Response Time 

Other than the basic parameters of processor-speed and memory, eZ-TOMAS server response may be 

affected by the number of concurrent clients and/or the types of display transactions taking place. 

 

 The monitoring of gauge data is a relatively light demand on a server; however, a large number 

of clients (eZ-TOMAS Remote applications) connected to one server may affect server response 

time.   

 A request for time or spectrum displays of real-time or historical data places a much larger 

network demand on the server.  Both time and spectrum displays result in time data for the 

number of specified channels being transferred from server to remote.    

Note:  The parameter which affects the amount of data transferred [for a given time frame or spectrum] is 

the spectral lines acquisition configuration parameter on the server (host eZ-TOMAS application).  

 

Network  Considerations 

There is a distinct difference in network response times when considering the following two scenarios: 

 Both the eZ-TOMAS Remote (client) and its host eZ-TOMAS application (server) reside on the 

same intranet. 

 The client and server are running across a VPN connection or across the open internet.  

To avoid excessive Offline occurrences, the Port Timeout setting will have to be set higher for the VPN and 

internet scenarios, as compared to when the client and server are on the same intranet. 
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Working with Previously Recorded Projects 

 

If you want to use eZ-TOMAS Remote to look at historical data from a previously recorded project, simply 

open the project with the application.  No server communication is required.  

 

However, note that you cannot use eZ-TOMAS Remote to look directly at archived data which resides on 

the PC that is host to eZ-TOMAS.  By archived data we mean data that has been saved, but that is not 

associated with the project currently opened.    

 

To view data from a previously recorded project, via eZ-TOMAS Remote, you need to do one of the 

following:   

 

(a) Copy the eZ-TOMAS project to the file system of the eZ-TOMAS Remote, or  

 

(b) Make the eZ-TOMAS project „network accessible‟ to the eZ-TOMAS Remote‟s file system. 

 

 

Troubleshooting 

 

 Symptom Comment 

1 Error messages 
received during 
historical data access 

Errors may occur during historical data access if  the rate at which storage is 
occurring is faster than network access time, and the FIFO has wrapped around.  

The error condition may be resolved by either  
   (a) stopping acquisition temporarily (if acceptable), or 
   (b) decreasing the rate of storage. 
 
For related information refer to the Storage Tab section on page 3-12. 

2 Client can’t connect 
to server 

1) In eZ-TOMAS, verify that the Enable Data Server check-box is checked  
(see page 10-7); if not, check it. 

2) If the client still cannot connect to the on-line server, go to the Server 
Connection dialog box in eZ-TOMAS Remote (see page 10-9).  Look at the 
‘Name/IP Address’ field for the associated server.  If the field shows the 
server’s host name, replace it with the server’s IP address.    

3 Server goes ‘Offline’ 
during operation 

If a server or server connection goes Offline during operation, the client will not 
continue attempts at reconnecting.  You can use the manual refresh button to 
attempt to restore the connection. 

Note that an excessive occurrence of Offline states, while a server is known to be 
available, is a strong indication that the Port Timeout should be set to a higher 
value.  Refer to An Explanation of Offline Status, page 10-12, for related 
information. 
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 Symptom Comment 

4 Slow retrieval of 
historical data from 
the server 

The amount of time required to retrieve data from a server is dependent upon 
several  factors: 
 

 speed and memory of the host computer 

 network response time  

 the amount of data being transferred 
 
Certain remote operations involve acquiring large amounts of data.  Such 
operations include viewing history data, alarm logs, and statistical reports.  To 
reduce the delay associated with retrieving historical data, decrease the FIFO size 
on the server [see History FIFO, page 3-12]. 
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